
1500 Bar Instructions

Watch the video on the Innova Art YouTube channel
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Gather all components together; 
bars at the required length, corner 
pieces, corner pins, glue, your print, 
a trimming tool and, if appropriate, 
a centre brace bar and corner tabs..

Turn the frame upside down.

Use a knife or the GOframe 
trimming tool to trim around the 
edges of your canvas.

Remove the release liner covering 
the tape.

Align with the back of your print 
using the notches in the corners 
sections as a guide.

Trim diagonally across each corner.

Insert the bar into the corner piece.

Apply pressure through the holes 
in the corner pieces to secure the 
bars to the back of your print.

Trim into each corner at an angle of 
approximately 45°, creating tabs at 
the end of each bar.

Building the shape of the frame.

Lift off each corner piece and store 
for future use.

Apply a thin bead of glue under the 
edge of each bar.

BCI IMAGING SUPPLIES www.bciimage.com 866 971-1008

BCI IMAGING SUPPLIES www.bciimage.com 866 971-1008



1500 Bar Instructions

Watch the video on the Innova Art YouTube channel

13 14 15 16
Fold up each tab created earlier 
and secure to the end of each 
bar.

Lift up each bar to create the 
canvas edge.

Insert a U-shaped pin into the 
pre drilled holes at each corner, 
apply pressure to secure the 
corner in place.

Turn Canvases Into 
Collages with Collage 

Clips from GOframe, visit 
www.innovaart.com for 

more details

For larger frames you will need 
to slot the corner tabs into the 
pre cut slots and possible insert  
a centre brace bar for additional 
tension.

Distributed 
by Innova
www.innovaart.com
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Nowadays it’s easy to print cards or invitations from an inkjet printer 
but when you want to make the very best impression – a truly 
memorable card for the people most important to you – Innova Art 
Cards are the best calling card.

Art Cards DS 220gsm
Fine Art Range 

Technical Specifications

www.innovaart.com

Available in two sizes, these cards can be printed in either landscape or 
portrait layout. Use the flat page size listed below to set up your page 
size in Photoshop and the user defined paper size in your printer driver. 
Additional instructions, layout templates and icc profiles can be found at 
www.innovaart.com 
The appealing natural white tone and luxurious, velvety smooth matte 
finish of Innova Art Cards brings elegance to every message you send. 
The archival quality, inkjet receptive card is specially coated on both 
sides, allowing you to print artwork on the front and your message on the 
inside.
Acid and lignin free this very special inkjet receptive media has been 
formulated with Innova Art’s most advanced coating technology ensuring 
that your treasured images are brought to life with bright, vivid colours, 
crisp, clear resolution and fine, subtle details.

Sizes Small: 148x229mm (Folded Size: 114x147.6mm), Large: 187x279mm (Folded Size: 140x187mm

Basic Weight (gsm) Card: 220, Envelope: 120

Paper Thickness (Microns) Card: 325 Paper Thickness (Inches) Card: 0.016

Base Material Alpha Cellulose

Coating Type Matte (2 Side Coated)

Surface Texture Slightly Textured

Whiteness (CIE) 115

Brightness (TAPPI) 99

OBA Content No

pH 7.5-9.5

Recycleable Yes

Print Settings* MK Ink, Enhanced Matte or Matte Photo Paper Settings are recommended as a starting point

Notes Envelope Style: Pointed Flap, Gummed; 100 Cards and Envelopes Per Box

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recomended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice.

The cards are pre-scored with matching envelopes, 
meaning you can produce mail-ready limited 
edition fine art cards, announcements and 
invitations whenever you want them, in quantities 
to suit you. 
Full details of where to buy Innova Art Cards are 
available from www.innovaart.com
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Art Cards DS 220gsm
Fine Art Range 

www.innovaart.com

Step 1:
Download the Photoshop templates from www.innovaart.com/
product/art-cards. Alternatively create a new document using 
the flat page dimensions listed below.

Step 2:
If using the downloaded template turn off or delete the layers 
with the Innova logos on them - these are on the ‘back’ of the 
card. 
Switch on the grid View>Show>Grid (View>Grid in some 
versions of Photoshop), this will help with alignment later on.

Step 3:
Use File>Place to import your desired image file by navigating 
to where you have saved your image and clicking place.

Step 4:
Use Edit>Transform>Rotate 90° CCW (or Image>Rotate>Layer 
Left in some versions of Photoshop) to orientate a portrait 
image with the right hand side of the document. This will be 
your bottom edge.
If you are using a landscape format image and would like 
to have a horizontal card use Edit>Transform>Rotate 180° 
(Image>Rotate>Layer 180° in some versions of Photoshop) 
to orientate the bottom of your image with the top of the 
document. This will be your bottom edge.

Step 5:
Use the ‘handles’ at the corners of your image to roughly 
size it to the appropriate dimensions. Remember to hold 
down the shift key on your keyboard to size the whole image 
proportionately and to resize to the whole image slightly larger 
than the final required size to compensate for border edits.
Drag your image so that the focal point of your image roughly 
lines up with the centre of the front of your card.
Press enter to secure your changes to the imported image.

Step 6:
To get an equal boarder around your image use the select the 
rectangular marquee tool (  ).
To get a border of 5mm on all sides set the Mode (in some 
versions of Photoshop this is called Style) drop down menu to 
fixed size. You can find this in the top tool bar.
For small cards set the dimensions to Width: 137.6mm Height: 
104.3mm.
For large cards set the dimensions to Width: 177.3mm Height: 
129.7mm.
Click on your image once to place the marquee then move the 
marquee to aline with the grid and get an equal border. 
Right click and select Layer via Copy.

Step 7:
You will now have your original image on one layer and a layer 
above called layer 1.
Switch off the layer containing your original image.

You can also turn off the grid using View>Show>Grid (or 
View>Grid), this will give you a clearer view of your final artwork.

Step 8:
Add any additional required details to the back of the card you 
could use the layers containing the Innova logo as a guide.
Save your file, you are now ready to print.

Additional notes:
•	 To print the inside of the card you will need to set up an 

additional file and print this separately. Practice with scrap 
paper first to make sure you are loading the paper correctly.

•	 ICC profiles are available from www.innovaart.com. Or use 
generic print settings listed in the reverse of this sheet.

•	 To print you card you will need to set up a custom page size 
using the dimensions below.

Folded Card Dimensions Flat Page Dimensions

Width Length Width Length

Size Inches mm Inches mm Inches mm Inches mm

Small 4.5 114 5.8 148 5.8 148 9.0 229

Large 5.5 140 7.4 187 7.4 187 11.0 279

Photoshop Set Up Instructions
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Art Cards DS 220gsm
Fine Art Range 

Printing Set Up Instructions

www.innovaart.com

Canon Printer Set-Up:
Select File > Print to bring up the Print Settings box.
Step 1:
Click on the Print Setings tab.

Step 2:
Under the Page Setup tab, click on the Page size drop down 
menu and select > Custom.
Step 3:
Enter the flat page size for either the small or large card > click 
OK to save.

Step 4:
You sould then see your image fill the entire paper surface in 
the preview on the left hand side.

Step 5:
Select your colour management preferences as usual using 
ICC profiles from www.innovaart.com, or using generic media 
settings with ‘Printer manages colour’.

Epson Printer Set-Up:
Select File > Print to bring up the Print Settings box.
Step 1:
Click on the Print Setings tab.

Step 2:
Under the Main tab > Paper Settings section, click on the size 
drop down menu and select > User Defined.
Step 3:
Enter the flat page size for either the small or large card.

Step 4: 
Name your user defined paper size, and click OK to save.
Step 5: 

You sould then see your image fill the entire paper surface in 
the preview on the left hand side.

Step 6: Select your colour management preferences as 
usual using ICC profiles from www.
innovaart.com, or using generic 
media settings with ‘Printer manages 
colour’.

Additional notes:
•	 To print the inside of the card you will need to set up an 

additional file, or Photoshop layer and print this separately. 
Practice with scrap paper first to make sure you are loading 
the paper correctly.

•	 Feed the cards into your printer one at a time.
•	 Load the cards with the crease facing inwards to allow the 

card to fold correctly.

The Art Cards are not standard page sizes, so to print your card, you will also need to set up a custom page size:
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Technical Specifications

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recomended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Basic Weight (gsm) 300

Paper Thicknesss (Microns) 325 Paper Thicknesss (Inches) 0.013

Base Material Alpha Cellulose

Coating Type Microporous Gloss

Surface Texture Smooth

Whiteness (CIE) 143

Brightness (TAPPI) 113

OBA Content Yes

pH 7.5-9.5

Recyclable Yes

Print Settings* PK Ink, Gloss, Semi Gloss or Lustre Photo Paper Settings are recommended as a starting point

Notes FibaPrint® glossy papers mark more easily, it is recommended to wear cotton gloves when 
handling

Applications
•	 Exhibition Display
•	 Photographic Reproduction and Restoration
•	 Photo Albums, Memory Books and Wedding Albums

Features
•	 Crystal Layer Technology, unique to FibaPrint®
•	 High White
•	 Fibre Based Photo Quality
•	 Archival - Acid and Lignin Free
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut and Exceptional D-max
•	 Instant Dry

Product Description
High White Fourdrinier Inkjet Art Paper with Smooth Glossy Surface and revolutionary Crystal Layer technology. Crystal Layer 
technology creates a barrier between the fibre base and the microporous glossy coating allowing the paper to maintain excellent 
sharp detail, an enhanced tonal range and an exceptional D-max rating.

FibaPrint® White Gloss (F-type) 300gsm
FibaPrint® Range IFA 09
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Technical Specifications

Features
•	 Crystal Layer Technology, unique to FibaPrint®
•	 Natural White
•	 Fibre Based Photo Quality
•	 Archival - Acid and Lignin Free
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut and Exceptional D-Max
•	 Instant Dry

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recomended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Basic Weight (gsm) 300

Paper Thickness (Microns) 325 Paper Thickness (Inches) 0.013

Base Material Alpha Cellulose

Coating Type Microporous Gloss

Surface Texture Smooth

Whiteness (CIE) 138

Brightness (TAPPI) 86

OBA Content No

pH 7.5-9.5

Recyclable Yes

Print Settings* PK Ink, Gloss, Semi Gloss or Lustre Paper Settings are recommended as a starting point

Notes FibaPrint® glossy papers mark more easily, it is recommended to wear cotton gloves when 
handling

Applications
•	 Fine Art and Fine Photographic Reproduction
•	 Photographic Restoration and Limited Edition Prints
•	 Photo Albums, Memory Books and Wedding Albums

Product Description
Natural White Alpha Cellulose Fourdrinier Inkjet Art Paper with Smooth Glossy Surface and revolutionary Crystal Layer 
technology. Crystal Layer technology creates a barrier between the fibre base and the microporous glossy coating allowing the 
paper to maintain excellent sharp detail, an enhanced tonal range and an exceptional D-max rating.

FibaPrint® Warmtone Gloss 300gsm
FibaPrint® Range IFA 19
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Technical Specifications

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recomended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Basic Weight (gsm) 300

Paper Thickness (Microns) 325 Paper Thickness (Inches) 0.013

Base Material Alpha Cellulose

Coating Type Microporous Satin

Surface Texture Smooth

Whiteness (CIE) 152

Brightness (TAPPI) 111

OBA Content Yes

pH 7.5-9.5

Recyclable Yes

Print Settings* PK Ink, Semi Gloss or Lustre Photo Paper Settings are recommended as a starting point

Notes FibaPrint® glossy papers mark more easily, it is recommended to wear cotton gloves when 
handling

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Fine Art and Fine Photographic Reproduction
•	 Fine Photographic Restoration and Limited Edition Prints
•	 Photo Albums, Memory Books and Wedding Albums

Features
•	 Crystal Layer Technology, unique to FibaPrint®
•	 High White
•	 Fibre Based Photo Quality
•	 Archival - Acid and Lignin Free
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut and Exceptional D-max
•	 Instant Dry

Product Description
High White Fourdrinier Inkjet Art Paper with Smooth Semi Matte Surface and revolutionary Crystal Layer technology. Crystal Layer 
technology creates a barrier between the fibre base and the microporous glossy coating allowing the paper to maintain excellent 
sharp detail, an enhanced tonal range and an exceptional D-max rating .

FibaPrint® White Semi Matte 300gsm
FibaPrint® Range IFA 29
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Technical Specifications

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recomended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Sheets A4, A3

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

Basic Weight (gsm) 380

Canvas Thickness (Microns) 450 Canvas Thickness (Inches) 0.018

Base Material Polycotton

Coating Type Microporous Gloss

Surface Texture Canvas

Whiteness (CIE) 85

Brightness (TAPPI) 86

OBA Content No

pH 7.5-9.5

Recyclable Yes

Print Settings* PK Ink, Gloss or Stain Canvas , Premium Lustre Photo Paper Settings are recommended as a 
starting point

Notes

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Stretched Canvases, Gallery Wraps
•	 Compatible with JetMaster Photo Wrap framing system

Features
•	 Crystal Layer Technology, unique to FibaPrint®
•	 High White
•	 Flexible Microporous Coating Ideal For Stretching
•	 Archival - Acid and Lignin Free
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut and Exceptional D-max
•	 Instant Dry and Water Resistant

Product Description
Polycotton canvas with Ultra Glossy Surface and revolutionary Crystal Layer technology. Crystal Layer technology creates a barrier 
between the canvas and the microporous glossy coating allowing the surface to maintain excellent sharp detail, an enhanced 
tonal range and an exceptional D-max rating.

FibaPrint® Photo Canvas Ultra Gloss 380gsm
FibaPrint® Range IFA 36
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Technical Specifications

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recomended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Basic Weight (gsm) 280

Paper Thickness (Microns) 310 Paper Thickness (Inches) 0.012

Base Material Alpha Cellulose

Coating Type Matte

Surface Texture Ultra Smooth

Whiteness (CIE) 138

Brightness (TAPPI) 111

OBA Content Yes

pH 7.5-9.5

Recyclable Yes

Print Settings* MK Ink, Archival Matte or Matte Photo Paper Settings are recommended as a starting point

Notes

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Fine Art and Fine Photographic Reproduction and 

Restoration
•	 Art and Photo Portfolios
•	 Photo Albums, Memory Books and Wedding Albums
•	 Glass Free Framing

Features
•	 Crystal Layer Technology, unique to FibaPrint®
•	 High White
•	 Fibre Based Photo Quality
•	 Archival - Acid and Lignin Free
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut and Exceptional D-max
•	 Instant Dry

Product Description
High White Fourdrinier Inkjet Art Paper with Ultra Smooth Matte Surface and revolutionary Crystal Layer technology. Crystal Layer 
technology creates a barrier between the fibre base and the matte coating allowing the paper to maintain excellent sharp detail, 
an enhanced tonal range and an exceptional D-max rating.

FibaPrint® White Matte 280gsm
FibaPrint® Range IFA 39
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Technical Specifications

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recomended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Basic Weight (gsm) 325

Paper Thickness (Microns) 325 Paper Thickness (Inches) 0.013

Base Material Alpha Cellulose

Coating Type Microporous Gloss

Surface Texture Ultra Smooth

Whiteness (CIE) 152

Brightness (TAPPI) 111

OBA Content Yes

pH 7.5-9.5

Recyclable Yes

Print Settings* PK Ink, Gloss or Semi Gloss Photo Paper Settings are recommended as a starting point

Notes FibaPrint® glossy papers mark more easily, it is recommended to wear cotton gloves when 
handling

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Fine Art and Fine Photographic Reproduction and 

Restoration
•	 Art and Photo Portfolios
•	 Greeting Cards and Postcards

Features
•	 Crystal Layer Technology, unique to FibaPrint®
•	 High White
•	 Fibre Based Photo Quality
•	 Archival - Acid and Lignin Free
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut and Exceptional D-max
•	 Instant Dry

Product Description
High White Fourdrinier Inkjet Art Paper with Ultra Smooth Glossy Surface and revolutionary Crystal Layer technology. Crystal 
Layer technology creates a barrier between the fibre base and the microporous glossy coating allowing the paper to maintain 
excellent sharp detail, an enhanced tonal range and a D-max rating up to 2.7.

FibaPrint® Ultra Smooth Gloss 325gsm
FibaPrint® Range IFA 40
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Technical Specifications

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recomended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Basic Weight (gsm) 250

Paper Thickness (Microns) 300 Paper Thickness (Inches) 0.012

Base Material Alpha Cellulose

Coating Type Microporous Gloss

Surface Texture Ultra Smooth

Whiteness (CIE) 152

Brightness (TAPPI) 111

OBA Content Yes

pH 7.5-9.5

Recyclable Yes

Print Settings* PK Ink, Gloss or Semi Gloss Photo Paper Settings are recommended as a starting point

Notes FibaPrint® glossy papers mark more easily, it is recommended to wear cotton gloves when 
handling

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Fine Art and Fine Photographic Reproduction and 

Restoration
•	 Art and Photo Portfolios
•	 Photo Albums, Memory Books and Wedding Albums

Features
•	 Crystal Layer Technology, unique to FibaPrint®
•	 High White
•	 Fibre Based Photo Quality
•	 Archival - Acid and Lignin Free
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut and Exceptional D-max
•	 Instant Dry

Product Description
High White Fourdrinier Inkjet Art Paper with Ultra Smooth Glossy Surface and revolutionary Crystal Layer technology. Crystal 
Layer technology creates a barrier between the fibre base and the microporous glossy coating allowing the paper to maintain 
excellent sharp detail, an enhanced tonal range and a D-max rating up to 2.7.

FibaPrint® Ultra Smooth Gloss 250gsm
FibaPrint® Range IFA 41

BCI IMAGING SUPPLIES www.bciimage.com 866 971-1008

BCI IMAGING SUPPLIES www.bciimage.com 866 971-1008



Technical Specifications

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recomended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Basic Weight (gsm) 250

Paper Thickness (Microns) 285 Paper Thickness (Inches) 0.011

Base Material Alpha Cellulose

Coating Type Microporous Satin

Surface Texture Ultra Smooth

Whiteness (CIE) 152

Brightness (TAPPI) 111

OBA Content Yes

pH 7.5-9.5

Recyclable Yes

Print Settings* PK Ink, Semi Gloss or Lustre Photo Paper Settings are recommended as a starting point

Notes FibaPrint® glossy papers mark more easily, it is recommended to wear cotton gloves when 
handling

Applications
•	 Fine Art and Fine Photographic Reproduction
•	 Fine Photographic Restoration and Limited Edition Prints
•	 Photo Albums, Memory Books and Wedding Albums

Features
•	 Crystal Layer Technology, unique to FibaPrint®
•	 High White
•	 Fibre Based Photo Quality
•	 Archival - Acid and Lignin Free
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut and Exceptional D-max
•	 Instant Dry

Product Description
High White Fourdrinier Inkjet Art Paper with Ultra Smooth Semi Matte Surface and revolutionary Crystal Layer technology. Crystal 
Layer technology creates a barrier between the fibre base and the microporous glossy coating allowing the paper to maintain 
excellent sharp detail, an enhanced tonal range and an exceptional D-max rating.

FibaPrint® White Semi Matte 250gsm
FibaPrint® Range IFA 42
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Basic Weight (gsm) 335

Paper Thickness (Microns) 390 Paper Thickness (Inches) 0.015

Base Material 100% Cotton

Coating Type Microporous Gloss

Surface Texture Smooth

Whiteness (CIE) 75

Brightness (TAPPI) 85

OBA Content None

pH 7.5-9.5

Recyclable Yes

Print Settings* PK Ink, Semi Gloss or Lustre Photo Paper Settings are recommended as a starting point

Notes FibaPrint® glossy papers mark more easily, it is recommended to wear cotton gloves when 
handling

FibaPrint® Warm Cotton Gloss 335gsm
FibaPrint® Range IFA 45
Product Description
Natural White 100% Cotton Fourdrinier Inkjet Art Paper with Smooth Glossy Surface and revolutionary Crystal Layer technology. 
Crystal Layer technology creates a barrier between the fibre base and the microporous glossy coating allowing the paper to 
maintain excellent sharp detail, an enhanced tonal range and an exceptional D-max rating.

Technical Specifications

Features
•	 Crystal Layer Technology, unique to FibaPrint®
•	 Natural White
•	 Fibre Based Photo Quality
•	 Archival - Acid and Lignin Free
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut and Exceptional D-Max
•	 Instant Dry

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Fine Art and Fine Photographic Reproduction and 

Restoration
•	 Art and Photo Portfolios
•	 Photo Albums, Memory Books and Wedding Albums
•	 Greeting Cards and Postcards

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recomended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.
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Technical Specifications

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recomended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Basic Weight (gsm) 285

Paper Thickness (Microns) 285 Paper Thickness (Inches) 0.011

Base Material Alpha Cellulose

Coating Type Microporous Gloss

Surface Texture Ultra Smooth

Whiteness (CIE) 152

Brightness (TAPPI) 111

OBA Content Yes

pH 7.5-9.5

Recyclable Yes

Print Settings* PK Ink, Gloss or Semi Gloss Photo Paper Settings are recommended as a starting point

Notes FibaPrint® glossy papers mark more easily, it is recommended to wear cotton gloves when 
handling

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Fine Art and Fine Photographic Reproduction and 

Restoration
•	 Art and Photo Portfolios
•	 Greeting Cards and Postcards

Features
•	 Crystal Layer Technology, unique to FibaPrint®
•	 High White
•	 Fibre Based Photo Quality
•	 Archival - Acid and Lignin Free
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut and Exceptional D-max
•	 Instant Dry

Product Description
High White Fourdrinier Inkjet Art Paper with Ultra Smooth Gloss Surface and revolutionary Crystal Layer technology. Crystal Layer 
technology creates a barrier between the fibre base and the microporous glossy coating allowing the paper to maintain excellent 
sharp detail, an enhanced tonal range and a D-max rating up to 2.7.

FibaPrint® Ultra Smooth Gloss 285gsm
FibaPrint® Range IFA 49
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Technical Specifications

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recomended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 50”, 44”, 36”, 24”, 17”

Basic Weight (gsm) 310

Paper Thickness (Microns) 315 Paper Thickness (Inches) 0.012

Base Material Alpha Cellulose

Coating Type Microporous Silk

Surface Texture Ultra Smooth

Whiteness (CIE) 100

Brightness (TAPPI) 96

OBA Content No

pH 7.5-9.5

Recyclable Yes

Print Settings* PK Ink, Semi Gloss or Lustre Photo Paper Settings are recommended as a starting point

Notes FibaPrint® glossy papers mark more easily, it is recommended to wear cotton gloves when 
handling

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Fine Art and Fine Photographic Reproduction and 

Restoration
•	 Art and Photo Portfolios
•	 Photo Albums, Memory Books and Wedding Albums
•	 Greeting Cards and Postcards
•	 Black and White Archival Prints

Features
•	 Crystal Layer Technology, unique to FibaPrint®
•	 Natural White
•	 True Barium Sulphate Layer
•	 Archival - Acid and Lignin Free
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut and Exceptional D-max
•	 Instant Dry

Product Description
Natural White Fourdrinier Inkjet Art Paper with Silky Smooth Surface and revolutionary Crystal Layer technology. Crystal Layer 
technology creates a barrier between the baryta base and the microporous glossy coating allowing the paper to maintain 
excellent sharp detail, an enhanced tonal range and an exceptional D-max rating.

FibaPrint® Baryta 310gsm
FibaPrint® Range IFA 69
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Technical Specifications

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Fine Art and Fine Photographic Reproduction and 

Restoration
•	 Art and Photo Portfolios
•	 Photo Albums, Memory Books and Wedding Albums
•	 Greeting Cards and Postcards

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

Basic Weight (gsm) 215

Paper Thickness (Microns) 290 Paper Thickness (Inches) 0.011

Base Material 100% Cotton

Coating Type Matte

Surface Texture Smooth

Whiteness (CIE) 109

Brightness (TAPPI) 99

OBA Content Yes

pH 7.5-9.5

Recyclable Yes

Print Settings* MK Ink, Fine Art or Matte Photo Paper Settings are recommended as a starting point

Notes

Features
•	 High White
•	 Archival - Acid and Lignin Free
•	 Instant Dry
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut
•	 Exceptional D-max

Product Description
Fourdrinier, acid-free, museum quality paper with a high white finish and silky smooth surface. 

Smooth Cotton High White 100% Cotton 215gsm
Fine Art Range IFA 04
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Technical Specifications

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Fine Art and Fine Photographic Reproduction and 

Restoration
•	 Art and Photo Portfolios
•	 Photo Albums, Memory Books and Wedding Albums
•	 Greeting Cards and Postcards

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls

Basic Weight (gsm) 225

Paper Thickness (Microns) 300 Paper Thickness (Inches) 0.012

Base Material 100% Cotton

Coating Type Matte (2 Side Coated)

Surface Texture Smooth

Whiteness (CIE) 109

Brightness (TAPPI) 99

OBA Content Yes

pH 7.5-9.5

Recyclable Yes

Print Settings* MK Ink, Fine Art or Matte Photo Paper Settings are recommended as a starting point

Notes

Features
•	 High White
•	 Archival - Acid and Lignin Free
•	 Instant Dry
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut
•	 Exceptional D-max

Smooth Cotton High White DS 100% Cotton 225gsm
Fine Art Range IFA 05
Product Description
Fourdrinier, acid-free, museum quality, two side coated paper with a high white finish and silky smooth surface.
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Product Description
Fourdrinier, acid-free, museum quality paper with a natural white finish and soft textured surface. 

Technical Specifications

Features
•	 Natural White
•	 Archival - Acid and Lignin Free
•	 Instant Dry
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut
•	 Exceptional D-max

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

Basic Weight (gsm) 190

Paper Thickness (Microns) 280 Paper Thickness (Inches) 0.011

Base Material Alpha Cellulose

Coating Type Matte

Surface Texture Soft Textured ‘Etching Paper’

Whiteness (CIE) 69

Brightness (TAPPI) 85

OBA Content No

pH 7.5-9.5

Recyclable Yes

Print Settings* MK Ink, Fine Art Textured or Archival Matte Paper Settings are recommended as a starting 
point

Notes

Applications
•	 Fine Art and Fine Photographic Reproduction 
•	 Photo Restoration
•	 Art and Photo Portfolios
•	 Greeting Cards and Postcards

Soft Textured Natural White 190gsm
Fine Art Range IFA 06
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Technical Specifications

Features
•	 Natural White
•	 Archival - Acid and Lignin Free
•	 Instant Dry
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut
•	 Exceptional D-max

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Fine Art and Fine Photographic Reproduction and 

Restoration
•	 Art and Photo Portfolios
•	 Photo Albums, Memory Books and Wedding Albums
•	 Greeting Cards and Postcards

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

Basic Weight (gsm) 315

Paper Thickness (Microns) 310 Paper Thickness (Inches) 0.012

Base Material 100% Cotton

Coating Type Matte

Surface Texture Smooth

Whiteness (CIE) 109

Brightness (TAPPI) 99

OBA Content No

pH 7.5-9.5

Recyclable Yes

Print Settings* MK Ink, Enhanced Matte or Fine Art Paper Settings are recommended as a starting point

Notes

Product Description
Fourdrinier, acid-free, museum quality paper with a natural white finish and silky smooth surface. 

Smooth Cotton Natural White 100% Cotton 315gsm
Fine Art Range IFA 11
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Basic Weight (gsm) 315

Paper Thickness (Microns) 380 Paper Thickness (Inches) 0.015

Base Material Alpha Cellulose

Coating Type Matte

Surface Texture Soft Textured ‘Etching Paper’

Whiteness (CIE) 109

Brightness (TAPPI) 99

OBA Content None

pH 7.5-9.5

Recyclable Yes

Print Settings* MK Ink, Fine Art Textured or Archival Matte Paper Settings are recommended as a starting 
point

Notes

Soft Textured Natural White 315gsm
Fine Art Range IFA 12
Product Description
Fourdrinier, acid-free, museum quality paper with a natural white finish and soft textured surface. 

Technical Specifications

Features
•	 Natural White
•	 Archival - Acid and Lignin Free
•	 Instant Dry
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut
•	 Exceptional D-max

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Fine Art and Fine Photographic Reproduction and 

Restoration
•	 Art and Photo Portfolios
•	 Photo Albums, Memory Books and Wedding Albums
•	 Greeting Cards and Postcards

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 
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Technical Specifications

Features
•	 Natural White
•	 Archival - Acid and Lignin Free
•	 Instant Dry
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut
•	 Exceptional D-max

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Fine Art and Fine Photographic Reproduction and 

Restoration
•	 Art and Photo Portfolios
•	 Photo Albums, Memory Books and Wedding Albums
•	 Greeting Cards and Postcards

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

Basic Weight (gsm) 315

Paper Thickness (Microns) 495 Paper Thickness (Inches) 0.019

Base Material Alpha Cellulose

Coating Type Matte

Surface Texture Rough Textured ‘Watercolour Paper’

Whiteness (CIE) 69

Brightness (TAPPI) 85

OBA Content No

pH 7.5-9.5

Recyclable Yes

Print Settings* MK Ink, Fine Art Textured or Archival Matte Paper Settings are recommended as a starting 
point

Notes

Product Description
Fourdrinier, acid-free, museum quality paper with a natural white finish and rough ‘watercolour’ textured surface. 

Cold Press Rough Textured Natural White 315gsm
Fine Art Range IFA 13
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Technical Specifications

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Fine Art and Fine Photographic Reproduction and 

Restoration
•	 Art and Photo Portfolios
•	 Photo Albums, Memory Books and Wedding Albums
•	 Greeting Cards and Postcards

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 72”, 60”, 44”, 36”, 24”, 17”

Basic Weight (gsm) 315

Paper Thickness (Microns) 390 Paper Thickness (Inches) 0.0154

Base Material 100% Cotton

Coating Type Matte

Surface Texture Smooth

Whiteness (CIE) 109

Brightness (TAPPI) 100

OBA Content Yes

pH 7.5-9.5

Recyclable Yes

Print Settings* MK Ink, Fine Art or Matte Photo Paper Settings are recommended as a starting point

Notes 72” Rolls only available in USA

Smooth Cotton High White 100% Cotton 315gsm
Fine Art Range IFA 14

Features
•	 High White
•	 Archival - Acid and Lignin Free
•	 Instant Dry
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut
•	 Exceptional D-max

Product Description
Fourdrinier, acid-free, museum quality paper with a high white finish and silky smooth surface. 

BCI IMAGING SUPPLIES www.bciimage.com 866 971-1008
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Technical Specifications

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Fine Art and Fine Photographic Reproduction and 

Restoration
•	 Art and Photo Portfolios
•	 Photo Albums, Memory Books and Wedding Albums
•	 Greeting Cards and Postcards

Basic Weight (gsm) 280

Paper Thickness (Microns) 415 Paper Thickness (Inches) 0.016

Base Material Cotton and Alpha Cellulose Mix

Coating Type Matte

Surface Texture Slightly Textured

Whiteness (CIE) 103

Brightness (TAPPI) 96

OBA Content Yes

pH 7.5-9.5

Recyclable Yes

Print Settings* MK Ink, Fine Art Textured or Archival Matte Paper Settings are recommended as a starting 
point

Notes

Features
•	 Natural White
•	 Archival - Acid and Lignin Free
•	 Instant Dry
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut
•	 Exceptional D-max
•	 25% Cotton Linters

Product Description
Fourdrinier, acid-free, museum quality paper made with 25% Cotton linters, featuring a natural white finish and slightly textured 
surface. 

Soft White Cotton 280gsm
Fine Art Range IFA 15
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Technical Specifications

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Fine Art and Fine Photographic Reproduction and 

Restoration
•	 Art and Photo Portfolios
•	 Photo Albums, Memory Books and Wedding Albums
•	 Greeting Cards and Postcards

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

Sheets A4, A3, A3+, A2, 914x610mm (36x24”), 914x1220mm (36x48”), 17x22”

Rolls (15m Length)

Basic Weight (gsm) 450

Paper Thickness (Microns) 455 Paper Thickness (Inches) 0.018

Base Material 100% Cotton

Coating Type Matte

Surface Texture Smooth

Whiteness (CIE) 109

Brightness (TAPPI) 100

OBA Content Yes

pH 7.5-9.5

Recyclable Yes

Print Settings* MK Ink, Enhanced Matte or Fine Art Paper Settings are recommended as a starting point

Notes

Features
•	 High White
•	 Archival - Acid and Lignin Free
•	 Instant Dry
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut
•	 Exceptional D-max

Product Description
Fourdrinier, acid-free, museum quality paper with a high white finish and silky smooth surface. 

Smooth Cotton High White 100% Cotton 450gsm
Fine Art Range IFA 18
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Product Description
Fourdrinier, acid-free, museum quality paper with a natural white finish and soft textured surface. 

Technical Specifications

Features
•	 Natural White
•	 Archival - Acid and Lignin Free
•	 Instant Dry
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut
•	 Exceptional D-max

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Fine Art and Fine Photographic Reproduction and 

Restoration
•	 Art and Photo Portfolios
•	 Photo Albums, Memory Books and Wedding Albums
•	 Greeting Cards and Postcards

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

Sheets A4, A3, A3+, A2, 8.5x11”, 11x17”, 13x19”, 17x22”

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

Basic Weight (gsm) 315

Paper Thickness (Microns) 460 Paper Thickness (Inches) 0.018

Base Material 100% Cotton

Coating Type Matte

Surface Texture Soft Textured ‘Etching Paper’

Whiteness (CIE) 109

Brightness (TAPPI) 86

OBA Content No

pH 7.5-9.5

Recyclable Yes

Print Settings* MK Ink, Fine Art Textured or Archival Matte Paper Settings are recommended as a starting 
point

Notes

Soft Textured Natural White 100% Cotton 315gsm
Fine Art Range IFA 22
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Technical Specifications

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

Sheets A4, A3, A3+, A2

Rolls (30m Length) 60”, 44”, 36”, 24”, 17”

Basic Weight (gsm) 245

Paper Thickness (Microns) 375 Paper Thickness (Inches) 0.016

Base Material Alpha Cellulose

Coating Type Matte

Surface Texture Rough Textured ‘Watercolour Paper’

Whiteness (CIE) 140

Brightness (TAPPI) 110

OBA Content Yes

pH 7.5-9.5

Recyclable Yes

Print Settings* MK Ink, Fine Art Textured or Archival Matte Paper Settings are recommended as a starting 
point

Notes

Applications
•	 Fine Art and Photographic Open Edition Prints
•	 Art and Photo Portfolios

Features
•	 Bright White
•	 Archival - Acid and Lignin Free
•	 Instant Dry
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut
•	 Exceptional D-max

Product Description
Fourdrinier, acid-free, museum quality paper designed for high volume inkjet printing, featuring a bright white finish and rough 
‘watercolour’ textured surface. 

Décor Watercolour Art 245gsm
Fine Art Range IFA 23
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Technical Specifications

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

Sheets A4, A3, A3+, A2

Rolls (30m Length) 60”, 44”, 36”, 24”, 17”

Basic Weight (gsm) 210

Paper Thickness (Microns) 225 Paper Thickness (Inches) 0.016

Base Material Alpha Cellulose

Coating Type Matte

Surface Texture Slightly Textured

Whiteness (CIE) 115

Brightness (TAPPI) 99

OBA Content No

pH 7.5-9.5

Recyclable Yes

Print Settings* MK Ink, Matte Photo or Enhanced Matte Paper Settings are recommended as a starting point

Notes

Applications
•	 Fine Art and Photographic Open Edition Prints
•	 Art Poster Reproduction
•	 Photo Albums, Memory Books and Wedding Albums

Features
•	 Natural White
•	 Archival - Acid and Lignin Free
•	 Instant Dry
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut
•	 Exceptional D-max

Product Description
Fourdrinier, acid-free, museum quality paper designed for high volume inkjet printing, featuring a natural white finish and slightly 
textured surface.

Décor Smooth Art 210gsm
Fine Art Range IFA 24
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Technical Specifications

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

Sheets A4, A3, A3+, A2

Rolls 

Basic Weight (gsm) 220

Paper Thickness (Microns) 325 Paper Thickness (Inches) 0.016

Base Material Alpha Cellulose

Coating Type Matte (2 Side Coated)

Surface Texture Slightly Textured

Whiteness (CIE) 115

Brightness (TAPPI) 99

OBA Content No

pH 7.5-9.5

Recyclable Yes

Print Settings* MK Ink, Matte Photo or Enhanced Matte Paper Settings are recommended as a starting point

Notes

Applications
•	 Fine Art and Photographic Open Edition Prints
•	 Art Poster Reproduction
•	 Photo Albums, Memory Books and Wedding Albums
•	 Greeting Cards and Postcards

Features
•	 Natural White
•	 Archival - Acid and Lignin Free
•	 Instant Dry
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut
•	 Exceptional D-max

Product Description
Fourdrinier. acid-free, museum quality, two side coated paper designed for high volume inkjet printing, featuring a natural white 
finish and slightly textured surface.

Décor Smooth Art DS 220gsm
Fine Art Range IFA 25
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Technical Specifications

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Fine Art and Fine Photographic Reproduction and 

Restoration
•	 Art and Photo Portfolios
•	 Photo Albums, Memory Books and Wedding Albums
•	 Greeting Cards and Postcards

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

Sheets A4, A3, A3+, A2, 8.5x11”, 13x19”, 17x22”

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

Basic Weight (gsm) 315

Paper Thickness (Microns) 460 Paper Thickness (Inches) 0.018

Base Material 100% Cotton

Coating Type Matte

Surface Texture Soft Textured ‘Etching Paper’

Whiteness (CIE) 136

Brightness (TAPPI) 110

OBA Content Yes

pH 7.5-9.5

Recyclable Yes

Print Settings* MK Ink, Fine Art Textured or Archival Matte Paper Settings are recommended as a starting 
point

Notes

Features
•	 Bright White
•	 Archival - Acid and Lignin Free
•	 Instant Dry
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut
•	 Exceptional D-max

Product Description
Fourdrinier, acid-free, museum quality paper with a bright white finish and soft textured surface. 

Soft Textured Bright White Cotton 315gsm
Fine Art Range IFA 26
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Technical Specifications

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

Sheets A4, A3, A3+, A2

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

Basic Weight (gsm) 300

Paper Thickness (Microns) 435 Paper Thickness (Inches) 0.016

Base Material Cotton and Alpha Cellulose Mix

Coating Type Matte

Surface Texture Rough Textured ‘Watercolour Paper’

Whiteness (CIE) 127

Brightness (TAPPI) 85

OBA Content Yes

pH 7.5-9.5

Recyclable Yes

Print Settings* MK Ink, Fine Art Textured or Archival Matte Paper Settings are recommended as a starting 
point

Notes

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Art and Photo Portfolios

Features
•	 Bright  White
•	 Archival - Acid and Lignin Free
•	 Instant Dry
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut
•	 Exceptional D-max
•	 Cotton Content

Product Description
Fourdrinier, acid-free, museum quality paper with cotton content and a bright white finish with rough textured ‘watercolour’ 
surface.

Cold Press Rough Textured Bright White Cotton 300gsm
Fine Art Range IFA 27
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Technical Specifications

*Generic ICC Profiles for selected printer models are available from the Innova Art website.

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice. 

Sheets A4, A3

Rolls (15m Length) 60”, 44”, 36”, 24”, 17”

Basic Weight (gsm) 350

Canvas Thickness (Microns) 405 Canvas Thickness (Inches) 0.016

Base Material Polycotton

Coating Type Matte

Surface Texture Canvas

Whiteness (CIE) 152

Brightness (TAPPI) 88

OBA Content Yes

pH 7.5-9.5

Recyclable Yes

Print Settings* MK Ink, an Art Matte Canvas Setting is recommended as a starting point

Notes

Applications
•	 Fine Art and Photographic Open and Limited Edition Prints
•	 Stretched Canvases and Gallery Wraps
•	 Compatible with JetMaster Photo Wrap framing system

Features
•	 High White
•	 Archival - Acid and Lignin Free
•	 Instant Dry
•	 Aqueous Pigment and Dye Ink Compatible
•	 Excellent Colour Gamut
•	 Exceptional D-max
•	 Compatible with Water based and Solvent giclée varnishes
•	 Ideal for stretching

Product Description
Polycotton Canvas with flexible Matte coating. 

Matte Canvas High White 350gsm
Fine Art Range IFA 35
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Matte Polyester Canvas 260gsm
Graphic Art Range  IFA 52

Basic Weight (gsm) 260

Paper Thickness (Microns) 330 Paper Thickness (Inches) 0.013

Base Material Polyester

Coating Type Water Based Matte

Surface Texture Canvas

Whiteness (CIE) >140

Brightness (TAPPI) Not Applicable

OBA Content Yes

Opacity (%) >85

pH 7.5

Recyclable Yes

Print Settings* MK ink, a Matte Art Canvas Setting is recommended as a starting point

Ink Type Aqueous

Notes *Generic ICC Profiles for selected printer models are available from the Innova Art website

Product Description
Inkjet coated Bright White canvas,  designed for value orientated, high volume print shops using Aqueous printers. 

Technical Specifications

Features
•	 Bright White
•	 Aqueous Pigment and Dye Ink Compatible
•	 Fast Drying, Scratch and Water Resistant Coating
•	 100% Polyester, Smooth Woven Canvas Surface
•	 Excellent Colour Gamut 
•	 High Level of Crack Resistance on Edges and Corners
•	 Easy to Stretch
•	 Lightweight and Economical

Applications
•	 Fine Art and Photographic Open Edition Prints for the Décor 

Art market
•	 Fine Art Reproduction Prints for Interior Imaging
•	 Stretched Canvases and Gallery Wraps
•	 Compatible with JetMaster Photo Wrap display system

Sheets

Rolls (15m Length, 3" Core) 60”, 44”, 36”, 24”, 17”

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice.
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Technical Specifications

Applications
•	 Fine Art and Photographic Open Edition Prints for the Décor 

Art market
•	 Fine Art Reproduction Prints for Interior Imaging
•	 Stretched Canvases and Gallery Wraps
•	 Compatible with JetMaster Photo Wrap display system

Sheets

Rolls (15m Length, 3" Core) 60”, 44”, 36”, 24”, 17”

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice.

Basic Weight (gsm) 380

Paper Thickness (Microns) 500 Paper Thickness (Inches) 0.019

Base Material Poly Cotton Mix

Coating Type Water Based Matte

Surface Texture Canvas

Whiteness (CIE) >130

Brightness (TAPPI) Not Applicable

OBA Content Yes

Opacity (%) >95

pH 7.5

Recyclable Yes

Print Settings* MK ink, a Matte Art Canvas Setting is recommended as a starting point

Ink Type Aqueous

Notes *Generic ICC Profiles for selected printer models are available from the Innova Art website

Features
•	 High White
•	 Aqueous Pigment and Dye Ink Compatible
•	 Fast Drying, Scratch and Water Resistant Coating
•	 Polycotton Mix, True Canvas Woven Surface
•	 Excellent Colour Gamut
•	 High Level of Crack Resistance on Edges and Corners
•	 Easy to Stretch
•	 Heavyweight

Product Description
Inkjet coated High White canvas,  designed for value orientated, high volume print shops using Aqueous printers. 

Matte Canvas High White 380gsm 
Graphic Art Range  IFA 55

BCI IMAGING SUPPLIES www.bciimage.com 866 971-1008

BCI IMAGING SUPPLIES www.bciimage.com 866 971-1008
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Technical Specifications

Applications
•	 Fine Art and Photographic Open Edition Prints for the Décor 

Art market
•	 Fine Art Reproduction Prints for Interior Imaging
•	 Stretched Canvases and Gallery Wraps
•	 Compatible with JetMaster Photo Wrap display system

Sheets

Rolls (15m Length, 3" Core) 60”, 44”, 36”, 24”, 17”

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice.

Basic Weight (gsm) 390

Paper Thickness (Microns) 520 Paper Thickness (Inches) 0.020

Base Material Poly Cotton Mix

Coating Type Microporous Gloss

Surface Texture Canvas

Whiteness (CIE) >75

Brightness (TAPPI) Not Applicable

OBA Content Not Applicable

Opacity (%) >95

pH 7.5

Recyclable Yes

Print Settings* PK ink, a Gloss or satin Canvas, or Premium Lustre Photo Paper Setting is recommended as a 
starting point

Ink Type Aqueous

Notes *Generic ICC Profiles for selected printer models are available from the Innova Art website

Features
•	 Natural White
•	 Aqueous Pigment and Dye Ink Compatible
•	 Instant Dry, Scratch and Water Resistant 
•	 Polycotton Mix, Canvas Woven Surface
•	 Flexible Microporous Gloss Coating
•	 Excellent Colour Gamut
•	 High Level of Crack Resistance on Edges and Corners
•	 Easy to Stretch, Heavyweight

Product Description
Inkjet coated Natural White canvas designed for Photo and Art reproduction by print shops using Aqueous printers. 

Gloss Polycotton Canvas 390gsm
Graphic Art Range  IFA 56

BCI IMAGING SUPPLIES www.bciimage.com 866 971-1008
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Technical Specifications

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice.
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Basic Weight (gsm) 200

Paper Thickness (Microns) 185 Paper Thickness (Inches) 0.007

Base Material Alpha Cellulose

Coating Type Eco-Solvent Gloss

Surface Texture Smooth

Whiteness (CIE) 140

Brightness (TAPPI) 100

OBA Content Yes

Opacity (%) 90

pH Not Applicable

Recyclable Yes

Ink Type Eco Solvent, UV and Latex

Notes For profiles please contact your rip vendor.

Sheets N/A

Rolls (30m Length, 3"Core) 60”, 54”, 30”

Applications
•	 Posters
•	 Open Edition Prints for the Décor Art market
•	 Point of Sale 

Features
•	 High White
•	 Excellent Image Quality
•	 Brilliant Colour Reproduction
•	 Eco-Solvent, Latex and UV Ink Compatible
•	 Scratch Resistant Coating
•	 Suitable for Indoor and Outdoor Application

Product Description
High white inkjet coated smooth paper designed for value orientated, high volume print shops using eco-solvent printers. 

Glossy Poster Paper 200gsm
Graphic Art Range  IFA 88

BCI IMAGING SUPPLIES www.bciimage.com 866 971-1008
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Technical Specifications

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice.
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Basic Weight (gsm) 200

Paper Thickness (Microns) 185 Paper Thickness (Inches) 0.007

Base Material Alpha Cellulose

Coating Type Eco-Solvent Satin

Surface Texture Smooth

Whiteness (CIE) 140

Brightness (TAPPI) 100

OBA Content Yes

Opacity (%) 90

pH N/A

Recyclable Yes

Ink Type Eco Solvent, UV and Latex

Notes For profiles please contact your rip vendor.

Sheets N/A

Rolls (30m Length, 3"Core) 60”, 54”, 30”

Applications
•	 Posters
•	 Open Edition Prints for the Décor Art market
•	 Point of Sale 

Features
•	 High White
•	 Excellent Image Quality
•	 Brilliant Colour Reproduction
•	 Eco-Solvent, Latex and UV Ink Compatible
•	 Scratch Resistant Coating
•	 Suitable For Indoor and Outdoor Application

Product Description
High white inkjet coated smooth paper designed for value orientated, high volume print shops using eco-solvent printers. 

Satin Poster Paper 200gsm
Graphic Art Range  IFA 89

BCI IMAGING SUPPLIES www.bciimage.com 866 971-1008
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Technical Specifications

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice.
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Basic Weight (gsm) 330

Paper Thickness (Microns) 506 Paper Thickness (Inches) 0.020

Base Material 100% Cotton

Coating Type Eco-Solvent Matte

Surface Texture Soft Textured ‘Etching Paper’

Whiteness (CIE) 109

Brightness (TAPPI) 86

OBA Content None

Opacity (%) 100

pH 7.5-9.5

Recyclable Yes

Ink Type Eco Solvent, UV and Latex

Notes For profiles please contact your rip vendor.

Sheets N/A

Rolls (25m Length, 3"Core) 60”, 54”, 30”

Applications
•	 Fine Art and Photographic Open Edition Prints for the Décor 

Art market
•	 Fine Art Reproduction Prints for Interior Imaging

Features
•	 Natural White, 100% Cotton
•	 Slighty Textured Matte surface
•	 Archival - Acid and Lignin Free
•	 Eco-Solvent, Latex and UV Ink Compatible
•	 Excellent Colour Gamut

Product Description
Natural white inkjet coated cotton paper  with a soft textured surface designed for value orientated, high volume print shops 
using eco-solvent printers. 

Décor Soft Textured Art 100% Cotton 330gsm
Graphic Art Range  IFA 92

BCI IMAGING SUPPLIES www.bciimage.com 866 971-1008
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Basic Weight (gsm) 260

Paper Thickness (Microns) 330 Paper Thickness (Inches) 0.013

Base Material Alpha Cellulose

Coating Type Eco-Solvent Satin

Surface Texture Rough Textured ‘Watercolour Paper’

Whiteness (CIE) 159

Brightness (TAPPI) 114

OBA Content Yes

Opacity (%) 100

pH 7.5-9.5

Recyclable Yes

Ink Type Eco Solvent, UV and Latex

Notes For profiles please contact your rip vendor.

Décor Art Rough Textured Bright White ES 260gsm
Graphic Art Range  IFA 93
Product Description
Bright white inkjet coated watercolour paper designed for value orientated, high volume print shops using eco-solvent printers. 

Technical Specifications

Features
•	 Bright White
•	 Eco-Solvent, Latex and UV Ink Compatible
•	 Excellent Colour Gamut

Applications
•	 Fine Art and Photographic Open Edition Prints for the Décor 

Art market
•	 Fine Art Reproduction Prints for Interior Imaging

Sheets

Rolls (25m Length, 3" Core) 60”, 54”, 30”

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice.
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Technical Specifications

Applications
•	 Fine Art and Photographic Open Edition Prints for the Décor 

Art market
•	 Fine Art Reproduction Prints for Interior Imaging

Sheets

Rolls (25m Length, 3" Core) 60”, 54”, 30”

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice.

ECO-S
O

LV
EN

T UV & LATEX

uv

C O M

PA
T

I B
L

E

A
Q

U

E O U S

A
Q

U

E O U S

ECO-S
O

LV
EN

T UV & LATEX

Basic Weight (gsm) 300

Paper Thickness (Microns) 432 Paper Thickness (Inches) 0.017

Base Material Alpha Cellulose

Coating Type Eco-Solvent Satin

Surface Texture Velvet Smooth

Whiteness (CIE) 166

Brightness (TAPPI) 116

OBA Content Yes

Opacity (%) 100

pH 7.5-9.5

Recyclable Yes

Ink Type Eco Solvent, UV and Latex

Notes For profiles please contact your rip vendor.

Features
•	 Bright White
•	 Velvet Smooth, Satin Surface
•	 Eco-Solvent, Latex and UV Ink Compatible
•	 Excellent Colour Gamut

Product Description
Bright white inkjet coated smooth paper designed for value orientated, high volume print shops using eco-solvent printers. 

Décor Velvet Art 300gsm
Graphic Art Range  IFA 94
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Technical Specifications

Sheets

Rolls (25m Length, 3" Core) 60”, 54”, 30”

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice.
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Basic Weight (gsm) 240

Paper Thickness (Microns) 340 Paper Thickness (Inches) 0.013

Base Material Polycotton

Coating Type Eco-Solvent Semi-Gloss

Surface Texture Canvas

Whiteness (CIE) >115

Brightness (TAPPI) 95.6

OBA Content No

Opacity (%) >83

pH 7.5

Recyclable Yes

Ink Type Eco Solvent, UV and Latex

Notes For profiles please contact your rip vendor.

Applications
•	 Fine Art and Photographic Open Edition Prints for the Décor 

Art market
•	 Fine Art Reproduction Prints for Interior Imaging
•	 Stretched Canvases and Gallery Wraps
•	 Compatible with JetMaster Photo Wrap display system

Features
•	 High White
•	 Eco-Solvent, Latex and UV Ink Compatible
•	 Fast Drying
•	 Scratch Resistant Coating, Waterproof
•	 Polycotton Mix
•	 High Level of Crack Resistance
•	 Lightweight and Economical

Product Description
Inkjet coated High White canvas designed for value orientated, high volume print shops using eco-solvent printers. 

Semi-Gloss Canvas ES 240gsm
Graphic Art Range  IFA 95
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Technical Specifications

Sheets

Rolls (25m Length, 3" Core) 60”, 54”, 30”

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice.
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Basic Weight (gsm) 370

Paper Thickness (Microns) 500 Paper Thickness (Inches) 0.019

Base Material Polycotton

Coating Type Eco-Solvent Semi-Gloss

Surface Texture Canvas

Whiteness (CIE) >95

Brightness (TAPPI) 95.6

OBA Content Yes

Opacity (%) >94

pH 7.5

Recyclable Yes

Ink Type Eco Solvent, UV and Latex

Notes For profiles please contact your rip vendor.

Applications
•	 Fine Art and Photographic Open Edition Prints for the Décor 

Art market
•	 Fine Art Reproduction Prints for Interior Imaging
•	 Stretched Canvases and Gallery Wraps
•	 Compatible with JetMaster Photo Wrap framing system

Features
•	 Bright White
•	 Eco-Solvent, Latex and UV Ink Compatible
•	 Fast Drying
•	 Scratch resistant Coating, Waterproof
•	 Polycotton Mix
•	 High Level of Crack Resistance
•	 Heavyweight, Textured Surface

Product Description
Inkjet Coated Bright White Canvas designed for value orientated, high volume print shops using eco-solvent printers. 

Semi-Gloss Canvas ES 370gsm
Graphic Art Range  IFA 96
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Technical Specifications

Sheets

Rolls (25m Length, 3" Core) 60”, 54”, 30”

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice.
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Basic Weight (gsm) 180

Paper Thickness (Microns) 225 Paper Thickness (Inches) 0.009

Base Material Alpha Cellulose

Coating Type Eco-Solvent Matte

Surface Texture Smooth

Whiteness (CIE) 92.5

Brightness (TAPPI) 95

OBA Content No

Opacity (%) 100

pH 7.5

Recyclable Yes

Ink Type Eco Solvent, UV and Latex

Notes For profiles please contact your rip vendor.

Applications
•	 Creative Wall Installations

Features
•	 Eco-Solvent, Latex and UV Ink Compatible
•	 Scratch Resistant Coating
•	 Smooth Matte Surface
•	 Suitable For Indoor Application
•	 No Specialist Knowledge Necessary for Installation
•	 Compatible With PVA Based Wallpaper Adhesive

Product Description
Inkjet coated paste up wallpaper designed for value orientated, high volume print shops using eco-solvent printers. 

Wallpaper Smooth Paste Up 180gsm
Graphic Art Range  IFA 98
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Technical Specifications

Sheets

Rolls (25m Length, 3" Core) 60”, 54”, 30”

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice.
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Basic Weight (gsm) 315

Paper Thickness (Microns) 320 Paper Thickness (Inches) 0.011

Base Material Alpha Cellulose

Coating Type Eco-Solvent Matte

Surface Texture Smooth

Whiteness (CIE) 92.5

Brightness (TAPPI) 96.5

OBA Content No

Opacity (%) 100

pH 7.5

Recyclable Yes

Ink Type Eco Solvent, UV and Latex

Notes For profiles please contact your rip vendor. All adhesive media has a tendency to delaminate 
from the release liner if left on the printer for too long. Remember to remove this product from 
the printer and secure the roll with tape after your job is complete.

Applications
•	 Creative Wall Installations

Features
•	 Eco-Solvent, Latex and UV Ink Compatible
•	 Scratch Resistant Coating
•	 Suitable For Indoor Application
•	 Removable Adhesive
•	 No Specialist Knowledge Necessary for Installation

Product Description
Inkjet coated self adhesive wallpaper designed for value orientated, high volume print shops using eco-solvent printers. 

Wallpaper Smooth Self Adhesive 315gsm
Graphic Art Range  IFA 99
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Technical Specifications

www.innovaart.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers and Canvases are fragile and need 

to be handled with extreme care. Try not to touch the surface 
of the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting or 
framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry (24 
hours is recommended). Do not stack prints on top of each 
other straight away.

•	 Using a giclée varnish or spray will help protect your print 
from damage, effects of UV light and environmental attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 15-

20°C, relative humidity of 40-60%. Always store in original 
packaging, out of direct sunlight and protected from 
moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our test 
criteria, which remain subject to change without prior notice.
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Basic Weight (gsm) 135

Film Thickness (Microns) 125 Film Thickness (Inches) 0.007

Base Material Polyester

Coating Type Eco-Solvent Gloss

Surface Texture Smooth

Whiteness (CIE) Not Applicable

Brightness (TAPPI) Not Applicable

OBA Content No

Opacity (%) 0

pH Not Applicable

Recyclable Yes

Ink Type Eco Solvent, UV and Latex

Notes For profiles please contact your rip vendor.

Sheets N/A

Rolls (25m Length, 3"Core) 60”, 42”, 30”

Applications
•	 Short Term Window Graphics
•	 Point of Sale Promotions

Features
•	 Crystal Clear
•	 Eco-Solvent, Latex and UV Ink Compatible
•	 Specialist Wet Cling Coating
•	 Apply to Inside of Window

Product Description
BCrystal clear polyester film designed for value orientated, high volume print shops using eco-solvent printers. 

Window Film Clear 
Graphic Art Range  IFA 100
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Print Area
39.96cm x 39.96cm

(face size : 30.5cm x 30.5cm)

www.jetmaster-systems.com

10.5cm Border 
between edge of 
frame and print area

4.3cm Border between 
face of finished frame 
and print area

3.8cm Border between face 
of finished frame and edge 
of finished frame

10.5cm

4.3cm

3.8cm

60.96cm

60.96 cm

10.5cm

4.3cm

3.8cm

10.5cm

4.3cm 3.8cm

12"x12" Direct Print JetMaster 
Frame Print Dimensions

Print Area
49.2cm x 59.4cm

(face size : 40.6cm x 50.8cm)

www.jetmaster-systems.com

10.5cm Border 
between edge of 
frame and print area

4.3cm Border between 
face of finished frame 
and print area

3.8cm Border between face 
of finished frame and edge 
of finished frame

10.5cm

4.3cm

3.8cm

80cm

70 cm

10.5cm

4.3cm

3.8cm

10.5cm

4.3cm 3.8cm

16"x20" Direct Print JetMaster 
Frame Print Dimensions

Print Area
59.4cm x 84.8cm

(Face size: 50.8cm x 76.2cm)

www.jetmaster-systems.com

10.5cm Border 
between edge of 
frame and print area

4.3cm Border between 
face of finished frame 
and print area

3.8cm Border between face 
of finished frame and edge 
of finished frame

10.5cm

4.3cm

3.8cm

10.5cm

4.3cm

3.8cm

10.5cm

4.3cm 3.8cm

105.7cm

80 cm

20"x30" Direct Print JetMaster 
Frame Print Dimensions

Frame Dimensions  
For use when creating files to print

12x12 Frame 16x20 Frame 20x30 Frame

Each frame has a border of 10.5cm 
between the outer edge and the print 
area, no part of the image should 
be printed on this area.

Each frame has a border of 4.3cm 
between the face of the frame and 
the edge of the print area, the part 
of the image in this area will be 
printed on the side of the finished 
frame and will overlap to the back 
of the frame by 0.5cm

Each frame has a border of 3.8cm 
between the face of the frame and 
the edge of the finished frame, this is 
the exact with of the side of the frame 
(1.5") any part of the image printed 
in this area will form the sides of 
the finished image.

www.jetmaster-systems.com
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JetMaster Direct Print Photo Panel Available From:

Design - Print - Display

www.innovaart.com
+44 (0) 1992 571775 | info@innovaart.com | +1 856-456-3200

Black Edging

Tabletop or Wall 
Mounted

Print Direct From 
A UV Flatbed 

Printer

General Specifications:
•  Direct UV printable
•  Thickness: 1 inch
•  Lightweight 
•  Pre drilled holes on back for easy hanging

Applications:
•  Permanent interior signage
•  High impact advertising
•  POS display and trade show graphics

Create effortless impact for your images. A lightweight 
alternative to solid MDF display blocks, this photo display frame 
can be printed directly on a UV flatbed printer; just position, print 
and display. The printable surface is finished in a bright white 
colour, no need to print white first, available in a range of sizes 
with a smart black matte edge finish.

Printer Compatibility:



 Swiss Qprint Nayla


 Jetrix 2030


 Océ


 EFI/Vutek


 FujiFilm


 Scitex 


 Mimaki


 Agfa


 Gandy

24x36”

18x24”

16x20”

8x10”

The JetMaster Image Display Systems Range is manufactured and distributed 
by Innova Art. For more information about Innova and their range of digital media 
visit www.innovaart.com

by Innova

Size  
(Inches) Printer Type

Depth Quantity per 
box

mm inches
8x10 UV Flat Bed / UV Hybrid 25 1 10

16x20 UV Flat Bed / UV Hybrid 25 1 5

18x24 UV Flat Bed / UV Hybrid 25 1 8

24x36 UV Flat Bed / UV Hybrid 25 1 5
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No Tools Required

Print Direct On A UV 
Flatbed Printer

Replicates a Traditional 
Canvas Wrap

JetMaster Direct Print Photo Wrap Available From:

Print Flat - Ship Flat - Fold - Display

www.innovaart.com
+44 (0) 1992 571775 | info@innovaart.com | +1 856-456-3200

Display System - Worldwide Patents Pending
All brands and images are used for illustration purposes only and remain the property of the original owner.

General Specifications:
•  Thickness: 2.2mm
•  Double walled corrugated
•  PSA back layer
•  Recycled content
•  Recyclable 
•  No tools required

•  Direct print (UV)
•  Simulates stretch canvas / textile
•  Prints and ships flat
•  Easy assembly 
•  Die cut holes for hanging

Applications:
•  Wall Art and Photo decor 
•  Display for home or office
•  Disposable display and trade show graphics
•  Temporary signage
•  Point of Sale display

It used to be difficult and expensive to ship canvas wraps to 
your customers. Now you can print and ship them flat and your 
customer can easily assemble the frame in their own home or 
office. 
Available in smooth and textured options, the JetMaster Direct 
Print is ideal for home décor, disposable point of sale displays 
as well as exhibition graphics and signage. The durable and 
lightweight prints can be stored and shipped flat without damage 
and be sold flat straight from the shop floor.
Simply position the flat frame on a UV flatbed printer, print, then 
either ship flat or create an instant canvas frame.

Size (Inches) Printer Type
Finished Face 

Size
Completed 

Frame Depth

mm inches mm inches

16x20 UV Flat Bed / UV Hybrid 406 x 508 16 x 20 38 1.5

20x30 UV Flat Bed / UV Hybrid 508 x 762 20 x 30 38 1.5

12x12 UV Flat Bed / UV Hybrid 305 x 305 12 x 12 38 1.5

Printer Compatibility:


Swiss Qprint Nayla


Jetrix 2030


Océ


EFI/Vutek


FujiFilm


Scitex 


Roland 

All sizes are available in smooth and 
textured finishes.

20x30”

16x20”

12x12”

The JetMaster Image Display Systems Range is manufactured and distributed 
by Innova Art. For more information about Innova and their range of digital media 
visit www.innovaart.com

by Innova

Mirror and StretchWrapMulti Colour

Create a range of edge effects for your Direct Print Photo Wrap 
frames using the Photoshop templates available online.
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Print Flat - Ship Flat - Fold - Display

www.innovaart.com
+44 (0) 1992 571775 | info@innovaart.com | +1 856-456-3200

Display System - Worldwide Patents Pending
All brands and images are used for illustration purposes only and remain the property of the original owner.

Assembly Instructions

Step 1:
After printing, place your Direct Print 
Photo Wrap on a flat surface and remove 
all corner sections.

Search JetMaster Systems on 
YouTube to watch the video

Step 2:
Turn your Direct Print Photo Wrap face 
down and pre fold along the scored lines.

Step 3:
Remove all of the release liner by pulling 
all edges into the centre and lifting off.

Step 4:
Fold over each of the edges without 
corner tabs (the long sides on rectangular 
frames), push out the flaps and apply 
pressure to on the flaps to secure them.

Step 5:
Fold up one of the edges with corner tabs 
(the short sides on rectangular frames) so 
it is square and tuck in the excess corner 
material.

Step 6:
Fold over the edge with corner tabs, 
making sure the edge of the corner tab is 
aligned with the inside of the frame and 
apply pressure on the tabs to secure the 
corners.

Step 7:
Push out the flaps and apply pressure to 
secure the edge to the back of the frame, 
repeat steps 5-7 for the other edge with 
corner tabs.

Step 8:
Fold up the edges of the backing tray and 
align with the back of the frame.

Step 9:
Push firmly on the backing tray to insert 
it into place and give a neat finish to your 
JetMaster Direct Print Photo Wrap.
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Basic Weight (gsm) 180

Board Type N/E Corrugated

Fluting 100% Recycled Fluting Material 90gsm

Middle Layer Test 95gsm

Bond Starch Based Adhesive

Thickness (mm) 2.2

JetMaster Photo Wrap Frame 
JMD
Product Description
Corrigated cardboard pre scored with a release liner to easily create a galley wrap frame.

Technical Specifications

Features
•	 Pre scored fold lines
•	 Release liner
•	 Pressure Sensitive Adhesive

Applications
•	 Canvas Effect Image Display
•	 Point of Sale Display
•	 Fine Art and Photographic Prints

www.jetmaster-systems.com

Conditions of Use
•	 The recommended climate for storage is 15-20°C, relative humidity of 

40-60%. Always store flat in original packaging, out of direct sunlight 
and protected from moisture.

All recommendations are for 
your guidance only. These 
are subject to our test criteria, 
which remain subject to 
change without prior notice.

Frame

Release Liner Siliconised PET, 50 Microns

Adhesive Polyvinyl Acetate Copolymer

Carrier Layer WTK 135gsm

PSA Layer
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Board Type N/E Corrugated

Top Liner WTK 135gsm

Fluting 100% Recycled Fluting Material 90gsm

Middle Liner Test 95gsm

Bottom Liner WTK 135gsm

Bond Starch Based Adhesive

Thickness (mm) 2.0

Printable Surface 180gsm, Coated Non Woven

Board Type N/E Corrugated

Fluting 100% Recycled Fluting Material 90gsm

Middle Layer Test 95gsm

Bond Starch Based Adhesive

Thickness (mm) 2.2

JetMaster Direct Print Photo Wrap Frame 
JMDP
Product Description
Corrigated cardboard coated with UV printable surface on one side. Pre scored and die cut with a pressure sensitive 
adhesive on the back to easily create a galley wrap frame.

Technical Specifications

Features
•	 Textured or Smooth UV compatible print surface
•	 Die cut with pre scored fold lines
•	 Pressure Sensitive Adhesive
•	 Recyclable

Applications
•	 Canvas Effect Image Display
•	 Point of Sale Display
•	 Fine Art and Photographic Prints

www.jetmaster-systems.com

Conditions of Use
•	 The recommended climate for storage is 15-20°C, relative humidity of 

40-60%. Always store flat in original packaging, out of direct sunlight 
and protected from moisture.

All recommendations are for 
your guidance only. These 
are subject to our test criteria, 
which remain subject to 
change without prior notice.

Frame

Release Liner Siliconised PET, 50 Microns

Adhesive Polyvinyl Acetate Copolymer

Carrier Layer WTK 135gsm

PSA Layer

Back
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Basic Weight (gsm) 200

Paper Thickness (Microns) 285 Paper Thickness (Inches) 0.011

Base Material Alpha Cellulose and Synthetic Fibres

Coating Type Matte

Surface Texture Smooth

Whiteness (CIE) 89

Brightness (TAPPI)

OBA Content No

Opacity (%) 94

pH 7.5-9.5

Recyclable Yes

Print Settings* Archival Matte Paper is recommended as a starting point

JetMaster Paper Smooth 200gsm 
JMP 20
Product Description
Inkjet paper custom made for mounting on the JetMaster Display Systems Photo Wrap frame. 

Technical Specifications

Features
•	 Instant Dry
•	 Pigment and dye ink compatible
•	 Archival - Acid and Lignin Free
•	 Aqueous and Dye Ink Comaptible
•	 Excellent colour gamut
•	 Exceptional D-max

Applications
•	 Display using the JetMaster Photo Wrap
•	 Fine Art and Photographic Prints
•	 Canvas Alternative For Wooden Frames

Sheets A4, A3+

Rolls (30m Length) 17”, 24”, 44”

www.jetmaster-systems.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers are fragile and need to be 

handled with extreme care. Try not to touch the surface of 
the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting 
or framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry. Do 
not stack prints on top of each other straight away.

•	 Using a giclée varnish or spray will help protect your 
print from damage, effects of UV light and environmental 
attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 

15-20°C, relative humidity of 40-60%. Always store in 
original packaging, out of direct sunlight and protected 
from moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our 
test criteria, which remain subject to change without prior notice.

*Generic ICC Profiles for selected printer models are available for free download online
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Product Description
Inkjet paper custom made for mounting on the JetMaster Display Systems Photo Wrap frame. 

Technical Specifications

Features
•	 Instant Dry
•	 Pigment and dye ink compatible
•	 Archival - Acid and Lignin Free
•	 Aqueous and Dye Ink Comaptible
•	 Excellent colour gamut
•	 Exceptional D-max

Applications
•	 Display using the JetMaster Photo Wrap
•	 Fine Art and Photographic Prints
•	 Canvas Alternative For Wooden Frames

Sheets A4, A3+

Rolls (30m Length) 17”, 24”, 44”

www.jetmaster-systems.com

Additional Sizes are available on request, subject to order quantity.

Handling and Storage
•	 All digital Fine Art Papers are fragile and need to be 

handled with extreme care. Try not to touch the surface of 
the paper, always hold the paper by the edges and wear 
cotton gloves if necessary.

•	 Return unused material to the original box and only store 
finished prints in archival quality packaging. If mounting 
or framing, use only archive grade tapes and glues.

•	 After printing, leave prints open to the air to fully dry. Do 
not stack prints on top of each other straight away.

•	 Using a giclée varnish or spray will help protect your 
print from damage, effects of UV light and environmental 
attack.

Conditions of Use
•	 The recommended climate for storage of all papers is 

15-20°C, relative humidity of 40-60%. Always store in 
original packaging, out of direct sunlight and protected 
from moisture.

•	 Do not exceed temperatures of 82°C (180°F) when dry 
mounting.

All recommendations are for your guidance only. These are subject to our 
test criteria, which remain subject to change without prior notice.

*Generic ICC Profiles for selected printer models are available for free download online

Basic Weight (gsm) 200

Paper Thickness (Microns) 285 Paper Thickness (Inches) 0.011

Base Material Alpha Cellulose and Synthetic Fibres

Coating Type Matte

Surface Texture Canvas Effect

Whiteness (CIE) 89

Brightness (TAPPI)

OBA Content No

Opacity (%) 94

pH 7.5-9.5

Recyclable Yes

Print Settings* Archival Matte Paper is recommended as a starting point

JetMaster Paper Canvas Embossed 200gsm 
JMP 21
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Smooth or 
Canvas Effect

Clean Corners  
When Stretched 

Over Frames

JetMaster Paper Available From:

The best type of media to use with the JetMaster Photo 
Wrap is one that is flexible and easy to wrap. This specially 
developed JetMaster Paper has been designed for the 
JetMaster Photo Wrap frames although we happen to think 
they look quite good on a JetMaster Photo Panel as well.
With a high polyester content and flexible coating, 
JetMaster Paper is tough as well as lightweight; it can even 
be stretched over a wooden frame like a traditional canvas.  
There is next to no drying time required, unlike 
conventional inkjet canvases which need to dry for 24 
hours before they can be stretched, JetMaster Paper is 
tough enough right off the printer and it is resistant to 
surface cracking, even on darker colours, meaning that 
your print looks as good when it is on the wall as the day it 
came off the printer. 
The perfect companion to creating JetMaster Photo Wraps. 
Available in two textures; Smooth (JMP20) and Canvas 
Effect (JMP21), both are inkjet compatible.

www.innovaart.com
+44 (0) 1992 571775 | info@innovaart.com | +1 856-456-3200

Eco-Solvent compatible available on request, subject to quantity.

Applications:
• Smooth and Canvas Effect finishes for JetMaster Photo Wraps
• Smooth and Canvas Effect finishes for JetMaster Photo Panels
• Canvas alternative for wooden frames
• Paste-Up wallpaper for short term installations

General Specifications:
• Tough
• Flexible
• Smooth or Canvas Effect surface
• ICC Profiles available
• Aqueous Inkjet Compatible

Ready To Use 
Straight From The 

Printer

The JetMaster Image Display Systems Range is manufactured and distributed 
by Innova Art. For more information about Innova and their range of digital media 
visit www.innovaart.com

by Innova

Available Sizes
Sheet Format Roll Format

JMP20 A4 A3+ 17" 24" 44"

JMP 21 A4 A3+ 8.5x11" 24" 44"

BCI IMAGING SUPPLIES www.bciimage.com 866 971-1008

BCI IMAGING SUPPLIES www.bciimage.com 866 971-1008



JetMaster Photo Panel Available From:

Print - Stick - Display

www.innovaart.com
+44 (0) 1992 571775 | info@innovaart.com | +1 856-456-3200

Tabletop or Wall 
Mounted Display

Choice of Black 
or White Edging

JetMaster Photo Panels look great when used with Olmec 
Photographic Papers - Also available from Innova Art

www.innovaart.com

Custom sizes and edge finishes available on request subject to 
quantity.

The JetMaster Photo Panel creates effortless impact for your 
images. A lightweight alternative to solid MDF display blocks, 
this photo mount has a pressure sensitive adhesive face and is 
available in a range of sizes with a choice of two smart matte 
edge finishes. JetMaster Photo Panels are  simple to create and 
can be wall mounted or used as an attractive addition to any desk. 
•	 Stylish frame free photo mount
•	 Choice of black or white matte edge finish
•	 Permanent pressure sensitive adhesive

The JetMaster Image Display Systems Range is manufactured and distributed 
by Innova Art. For more information about Innova and their range of digital media 
visit www.innovaart.com

by Innova

Print Size 
(Inches)

Depth 
Printer Type Finished face 

size (Inches)
Quantity 
Per Boxmm inches

A4 25 1 Desktop 11.3x7.9 10

B
la

ck
 E

dg
e 

O
nl

y

A3 25 1 Desktop 16.1x11.3 8

A3+ 25 1 17” roll/ A3+ sheet fed 18.6x12.5 8

5x5 25 1 Desktop 4.7x4.7 10

B
la

ck
 o

r W
hi

te
 E

dg
e

5x7 25 1 Desktop  4.7x6.7 10

6x8 25 1 Desktop 6.7x7.7 10

8x8 25 1 Desktop 7.7x7.7 10

8x10 25 1 Desktop 7.7x9.7 10

8x12 25 1 Desktop 7.7x11.75 10

11x14 25 1 17” roll/ A3+ sheet fed 10.7x13.7 10

12x12 25 1 17” roll/ A3+ sheet fed 11.75x11.75 8

12x16 25 1 17” roll/ A3+ sheet fed 11.75x15.75 8

16x16 25 1 17” roll/ A2 sheet fed 15.75x15.75 8

16x20 25 1 17” roll/ A2 sheet fed 15.75x19.7 8

16x24 25 1 17” roll/ A2 sheet fed 15.75x23.6 8

24x24 25 1 24” roll/ A1 sheet fed 23.6x23.6 8

24x30 25 1 36” roll/ A1 sheet fed 23.6x31.5 5

Available Whilst Stocks Last

12x24 25 1 17” roll/ A2 sheet fed 11.8x23.6 8

B
la

ck
 o

r W
hi

te
 

E
dg

e14x20 25 1 17” roll/ A2 sheet fed 13.8x19.7 8

20x20 25 1 24” roll/ A1 sheet fed 19.7x19.7 8

28x28 25 1 36” roll/ A1 sheet fed 27.6x27.6 5

28x28"

20x20"

14x20"

12x24"

8x10"

5x7"
6x8"

24x24"

16x16"

8x8"

5x5"

12x12"

11x14"
8x12"

12x16"

24x30"

16x24"

16x20"
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Print - Stick - Display

www.innovaart.com
+44 (0) 1992 571775 | info@innovaart.com | +1 856-456-3200

Assembly Instructions

Search JetMaster Systems on 
YouTube to watch the video

To get the best results print your image to the size specified in the print size column of the table on the previous page. 
Experiment with a range of finishes on the face of your photo panel by printing your image on different medias.

Step 1:
Peel back a small section of the 
release liner.

Step 2:
Place the photo panel into the 
alignment frame and fold back part 
of the release liner

Step 3:
Position your image using the 
alignment frame. 

Step 4:
Secure a corner of your print using 
the area of adhesive you exposed 
earlier

Step 5:
Remove the rest of the release liner 
and apply even pressure using a 
roller.

Step 6:
Place your photo panel face down 
on a cutting mat and use a rotary 
cutter or craft knife to remove the 
excess paper from the edges.

Step 7:
Insert the desk stand into one of the  pre drilled holes 
on smaller frames or use the slits on the back of larger 
frames to display your finished photo panel

JetMaster Photo Panel Tools
Cutting Mats, Alignment Tools and Rollers are all 
available from JetMaster Display Systems, contact 
us for further details. Rotary Cutters and Craft 
Knives are available separately.
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JetMaster Photo Wrap Available From:

Print - Wrap - Display

www.innovaart.com
+44 (0) 1992 571775 | info@innovaart.com | +1 856-456-3200

Create edge effects on your Photo Wrap print with ease 
using our free online upload utility. In three simple steps 
you will have a print ready PDF to download and save.

Free Online JetMaster Print Utility

Replicates a 
Traditional 

Canvas Wrap

Desktop 
or Wall 

Mounted

With no need for stretcher bars, glue or staples, the JetMaster 
Photo Wrap reduces the time it takes to produce a professional 
gallery wrap to minutes. Using just a craft knife and cutting mat 
or scissors no special skills are required and using the specially 
developed JetMaster Paper means you can mount your prints 
straight from the printer with no drying time required.

The base is pre cut laminated self adhesive board. Simply remove 
the release liner and press your print into place. No bubbles 
when mounting and no battle against untidy corners, just tuck 
in the excess media and keep constructing your frame. A fully 
assembled JetMaster Photo Wrap can be hung from just one tack.

There is no longer any need in retail for expensive outsourcing 
of canvas wraps to specialist print shops. You can offer your 
customers a one stop shopping experience and, with the online 
upload utility, they can have a finished gallery wrap in under half 
an hour.

5x7.5

A4
Letter

8x12

9x15

A3+ (13x19)
12x12

12x16

16x20

8x8

5x5

9x14 11x14

Display System - Worldwide Patents Pending

Print media is not included with frames.

The JetMaster Image Display Systems Range is manufactured and distributed 
by Innova Art. For more information about Innova and their range of digital media 
visit www.innovaart.com

by Innova

Size  
(inches)

Media Size Minimum Printer 
Size Required

Finished Face size Finished 
Frame Depth

Inches mm Inches mm Inches mm

11x14 14x17 356x432 17” roll/ A2 sheet fed 11x14 280x357 1.5 38

12x12 17.95x17.95 456x456 24” roll/ A1 sheet fed 12x12 305x305 1.5 38

16x20 22x26 559x661 24” roll/ A1 sheet fed 16x20 406x508 1.5 38

Available Whilst Stocks Last

5x5 8x8 204x204 Desktop/ A4 sheet fed 4.8x4.8 123x123 0.8 20

5x7.5 8x10.36 204x264 Desktop/ A4 sheet fed 4.8x7.2 123x184 0.8 20

A4 8.3x11.7 210x297 Desktop/ A4 sheet fed 5.2x8.6 131x218 0.8 20

Letter 8.5x11 216x280 17” roll/ A3 sheet fed 5.3x7.8 135x198 0.8 20

8x8 12x12 305x305 17” roll/ A3+ sheet fed 7.9x7.9 203x203 1 25

8x12 12x16 305x405 17” roll/ A3+ sheet fed 7.9x12 203x305 1 25

9x14 13.25x18.17 337x462 17” roll/ A2 sheet fed 9.2x14.1 235x360 1 25

9x15 13.25x19.17 337x487 17” roll/ A2 sheet fed 8.9x15 228x381 1 25

A3+ (13x19) 13x19 329x483 17” roll/ A3+ sheet fed 9.8x13 249x332 0.8 20

12x12 16.73x16.73 425x425 17” roll/ A1 sheet fed 12x12 305x305 1.1 30

12x16 16.73x20.73 425x527 17” roll/ A1 sheet fed 12x16 305x406 1.1 30

16x20 29.72x24.72 755x628 36” roll/ A0 sheet fed 16x20 406x508 1.1 30
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Print - Wrap - Display

www.innovaart.com
+44 (0) 1992 571775 | info@innovaart.com | +1 856-456-3200

Display System - Worldwide Patents Pending
All brands and images are used for illustration purposes only and remain the property of the original owner.

Assembly Instructions

Step 1:
Remove part of the release liner 
and fold it back.

Search JetMaster Systems on 
YouTube to watch the video

Step 3:
Carefully fold back your print and 
remove the rest of the release 
liner.

Step 4:
Place your print over the exposed 
adhesive and apply pressure 
using your hand or a roller  to 
secure it in place.

Step 5:
Pre fold all the creased lines on 
the back of the frame, ensure the 
face of your print is on a clean 
work surface.

Step 6:
Use scissors to cut straight across 
each of the corner sections to 
remove the excess media.

Step 7:
Fold up one edge of the frame 
and release the preforated tabs.

Step 9:
Keeping the edge square apply 
firm pressure to secure the tabs 
to the back of the frame.

Step 2:
Align your print with the interior 
perforated line around the edge 
of the frame.

Step 8:
Fold the edge around until it 
forms a square.

Step 11:
Gently support each corner to 
keep it square and apply the 
corner sticker to keep it in place.

Step 10:
Repeat this process for each 
edge tucking in the media at 
each corner.

Step 13; Wall Hanging Frames:
Place the backing tray into the 
back of the frame and press 
firmly in the centre to secure it to 
the exposed adhesive.

Step 12; Wall Hanging Frames:
Fold the edges of the backing 
tray up.

Step 13; Desktop Frames:
Place the backing tray into the 
back of the frame, taking care to 
make sure the desk stand is free.

Step 12; Desktop Frames:
Fold the edges of the backing 
tray down and release the desk 
stand.
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TECHNICAL DATA SHEET

www.innovaart.com
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Directions for Use:

Paper Handling:
•	 Avoid touching the coated surface of the paper before and after printing, 

and wear cotton gloves if necessary.
•	 Avoid exposure to high temperatures, high levels of humidity and moisture. 

These factors can affect the drying time of some Olmec™ products.

Paper Storage:
•	 Remove prints from the tray after printing; do not allow them to be stacked.
•	 Prints should be allowed to dry in air, preferably left uncovered for 24 hours 

to allow the residual liquid from the inks to evaporate.
•	 In cases where stacking is unavoidable, a paper interleaf should be placed 

between each print.

Conditions of Use:
•	 Where possible, all paper should be stored and used within the following 

range of environmental conditions:
Temperature = 10°- 35°Centigrade
Relative Humidity = 30% - 80%

•	 Unused paper should be stored in its original packaging, out of direct 
sunlight under normal climatic conditions.

All recommendations and product indications are for your guidance, and are subject 
to our test criteria. 

This Bright White Photo RC inkjet paper provides excellent image quality, on its smooth gloss surface.

Applications include; soft proofing, albums and portfolios, poster and graphic art reproduction

Photo Papers Lightweight

Photo Gloss Lightweight 190gsm
OLM62

P R O F E S S I O N A L  P H O T O G R A P H I C  I N K J E T  PA P E R

Weight (GSM) 190

Base Material Resin Coated

Coating Type Microporous Gloss

Surface Texture Smooth high gloss

Thickness (Microns / inches) 207 / 0.008

Whiteness (CIE) 152

Brightness (TAPPI) 112

OBA content Yes

pH 7.5-9.5

Sheets Size: 
Availability / sheets per box

DIN A4 / A3 / A3+ / A2  - 100 sheets 
(US sizes available on request) 

Roll Size: 
Availablity / Length / Core size

17” (432mm) / 24” (610mm) / 44” (1118mm) / 30m /  2” core

Printer/Ink Compatibility Compatible with all commercial thermal and piezo inkjet printers using water-based dye and 
pigment-based inks such as Epson, Canon and Hewlett-Packard

Recommended printer 
Settings

Photo black inks with generic media setting of ‘Photo paper gloss/ ‘Photo paper glossy’ or 
similar. ICC colour profiles are available from the website.

Description:

BCI IMAGING SUPPLIES www.bciimage.com 866 971-1008

BCI IMAGING SUPPLIES www.bciimage.com 866 971-1008



TECHNICAL DATA SHEET

www.innovaart.com
Rev.0714 

Directions for Use:

Paper Handling:
•	 Avoid touching the coated surface of the paper before and after printing, 

and wear cotton gloves if necessary.
•	 Avoid exposure to high temperatures, high levels of humidity and moisture. 

These factors can affect the drying time of some Olmec™ products.

Paper Storage:
•	 Remove prints from the tray after printing; do not allow them to be stacked.
•	 Prints should be allowed to dry in air, preferably left uncovered for 24 hours 

to allow the residual liquid from the inks to evaporate.
•	 In cases where stacking is unavoidable, a paper interleaf should be placed 

between each print.

Conditions of Use:
•	 Where possible, all paper should be stored and used within the following 

range of environmental conditions:
Temperature = 10°- 35°Centigrade
Relative Humidity = 30% - 80%

•	 Unused paper should be stored in its original packaging, out of direct 
sunlight under normal climatic conditions.

All recommendations and product indications are for your guidance, and are subject 
to our test criteria. 

This Bright White Photo RC inkjet paper provides excellent image quality, on its smooth lustre surface. 

Applications include; soft proofing, albums and portfolios, poster and graphic art reproduction

Photo Papers Lightweight

Photo Lustre Lightweight 190gsm
OLM68

P R O F E S S I O N A L  P H O T O G R A P H I C  I N K J E T  PA P E R

Weight (GSM) 190

Base Material Resin Coated

Coating Type Microporous Lustre

Surface Texture Slightly textured stippled lustre

Thickness (Microns / inches) 207 / 0.008

Whiteness (CIE) 152

Brightness (TAPPI) 112

OBA content Yes

pH 7.5-9.5

Sheets Size: 
Availability / sheets per box

DIN A4 / A3 / A3+ / A2  - 100 sheets 
(US sizes available on request) 

Roll Size: 
Availablity / Length / Core size

17” (432mm) / 24” (610mm) / 44” (1118mm) / 30m /  2” core

Printer/Ink Compatibility Compatible with all commercial thermal and piezo inkjet printers using water-based dye and 
pigment-based inks such as Epson, Canon and Hewlett-Packard

Recommended printer 
Settings

Photo black inks with generic media setting of ‘Photo paper lustre/ ‘Photo paper Semi-matte’ 
or similar. ICC colour profiles are available from the website.

Description:
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Directions for Use:

Paper Handling:
•	 Avoid touching the coated surface of the paper before and after printing, 

and wear cotton gloves if necessary.
•	 Avoid exposure to high temperatures, high levels of humidity and moisture. 

These factors can affect the drying time of some Olmec™ products.

Paper Storage:
•	 Remove prints from the tray after printing; do not allow them to be stacked.
•	 Prints should be allowed to dry in air, preferably left uncovered for 24 hours 

to allow the residual liquid from the inks to evaporate.
•	 In cases where stacking is unavoidable, a paper interleaf should be placed 

between each print.

Conditions of Use:
•	 Where possible, all paper should be stored and used within the following 

range of environmental conditions:
Temperature = 10°- 35°Centigrade
Relative Humidity = 30% - 80%

•	 Unused paper should be stored in its original packaging, out of direct 
sunlight under normal climatic conditions.

All recommendations and product indications are for your guidance, and are subject 
to our test criteria. 

A Neutral White Photo RC inkjet paper that provides excellent image quality, on its high gloss surface. Its smooth surface makes it 
ideal for portraiture.

Applications include;  Photography, portrait printing, posters and graphic art reproduction

Photo Papers Midweight

Photo Gloss Midweight 240gsm  
OLM63

P R O F E S S I O N A L  P H O T O G R A P H I C  I N K J E T  PA P E R

Weight (GSM) 240

Base Material Resin Coated

Coating Type Microporous Gloss

Surface Texture Smooth high gloss

Thickness (Microns / inches) 236 / 0.016

Whiteness (CIE)

Brightness (TAPPI)

OBA content Yes

pH 7.5-9.5

Sheets Size: 
Availability / sheets per box

DIN A4 / A3 / A3+ / A2  - 50 sheets 
(US sizes available on request) 

Roll Size: 
Availablity / Length / Core size

17” (432mm) / 24” (610mm) / 44” (1118mm) / 30m /  2” core

Printer/Ink Compatibility Compatible with all commercial thermal and piezo inkjet printers using water-based dye and 
pigment-based inks such as Epson, Canon and Hewlett-Packard

Recommended printer 
Settings

Photo black inks with generic media setting of ‘Photo Gloss heavyweight’ / ‘Premium Photo 
paper Glossy’ or similar. ICC colour profiles are available from the website.

Description: © Keith Cooper
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Directions for Use:

Paper Handling:
•	 Avoid touching the coated surface of the paper before and after printing, 

and wear cotton gloves if necessary.
•	 Avoid exposure to high temperatures, high levels of humidity and moisture. 

These factors can affect the drying time of some Olmec™ products.

Paper Storage:
•	 Remove prints from the tray after printing; do not allow them to be stacked.
•	 Prints should be allowed to dry in air, preferably left uncovered for 24 hours 

to allow the residual liquid from the inks to evaporate.
•	 In cases where stacking is unavoidable, a paper interleaf should be placed 

between each print.

Conditions of Use:
•	 Where possible, all paper should be stored and used within the following 

range of environmental conditions:
Temperature = 10°- 35°Centigrade
Relative Humidity = 30% - 80%

•	 Unused paper should be stored in its original packaging, out of direct 
sunlight under normal climatic conditions.

All recommendations and product indications are for your guidance, and are subject 
to our test criteria. 

This Neutral White Photo RC inkjet paper provides excellent image quality, on its smooth satin surface. 

Applications include; Photography, portrait printing, posters and graphic art reproduction

Photo Papers Midweight

Photo Satin Midweight 240gsm  
OLM64

P R O F E S S I O N A L  P H O T O G R A P H I C  I N K J E T  PA P E R

Weight (GSM) 240

Base Material Resin Coated

Coating Type Microporous Satin

Surface Texture Smooth satin

Thickness (Microns / inches) 236 / 0.016

Whiteness (CIE) 145

Brightness (TAPPI)

OBA content Yes

pH 7.5-9.5

Sheets Size: 
Availability / sheets per box

DIN A4 / A3 / A3+ / A2  - 50 sheets 
(US sizes available on request) 

Roll Size: 
Availablity / Length / Core size

17” (432mm) / 24” (610mm) / 44” (1118mm) / 30m /  2” core

Printer/Ink Compatibility Compatible with all commercial thermal and piezo inkjet printers using water-based dye and 
pigment-based inks such as Epson, Canon and Hewlett-Packard

Recommended printer 
Settings

Photo black inks with generic media setting of ‘Photo semi-gloss heavyweight’ / ‘Premium 
Photo paper semi-gloss’ or similar. ICC colour profiles are available from the website.

Description:
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Directions for Use:

Paper Handling:
•	 Avoid touching the coated surface of the paper before and after printing, 

and wear cotton gloves if necessary.
•	 Avoid exposure to high temperatures, high levels of humidity and moisture. 

These factors can affect the drying time of some Olmec™ products.

Paper Storage:
•	 Remove prints from the tray after printing; do not allow them to be stacked.
•	 Prints should be allowed to dry in air, preferably left uncovered for 24 hours 

to allow the residual liquid from the inks to evaporate.
•	 In cases where stacking is unavoidable, a paper interleaf should be placed 

between each print.

Conditions of Use:
•	 Where possible, all paper should be stored and used within the following 

range of environmental conditions:
Temperature = 10°- 35°Centigrade
Relative Humidity = 30% - 80%

•	 Unused paper should be stored in its original packaging, out of direct 
sunlight under normal climatic conditions.

All recommendations and product indications are for your guidance, and are subject 
to our test criteria. 

Weight (GSM) 260

Base Material Resin Coated

Coating Type Microporous gloss

Surface Texture Smooth high gloss

Thickness (Microns / inches) 265 / 0.016

Whiteness (CIE) 152

Brightness (TAPPI) 112

OBA content Yes

pH 7.5-9.5

Sheets Size: 
Availability / sheets per box

DIN A4 / A3 / A3+ / A2  - 50 sheets 
(US sizes available on request) 

Roll Size: 
Availablity / Length / Core size

17” (432mm) / 24” (610mm) / 44” (1118mm) / 60” (1524mm) - 30m - 3” core

Printer/Ink Compatibility Compatible with all commercial thermal and piezo inkjet printers using water-based dye and 
pigment-based inks such as Epson, Canon and Hewlett-Packard

Recommended printer 
Settings

Photo black inks with generic media setting of ‘Photo Gloss heavyweight’ / ‘Premium Photo 
paper Glossy’ or similar. ICC colour profiles are available from the website.

Photo Papers Heavyweight

Photo Gloss Heavyweight 260gsm  
OLM60

P R O F E S S I O N A L  P H O T O G R A P H I C  I N K J E T  PA P E R

This Ultra White Photo RC inkjet paper provides excellent image quality on its smooth high gloss surface. It has a microporous 
coating which is dry to the touch when printed and water resistant. 

Applications include; Photography, portrait printing, posters and graphic art reproduction.

Description:
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Directions for Use:

Paper Handling:
•	 Avoid touching the coated surface of the paper before and after printing, 

and wear cotton gloves if necessary.
•	 Avoid exposure to high temperatures, high levels of humidity and moisture. 

These factors can affect the drying time of some Olmec™ products.

Paper Storage:
•	 Remove prints from the tray after printing; do not allow them to be stacked.
•	 Prints should be allowed to dry in air, preferably left uncovered for 24 hours 

to allow the residual liquid from the inks to evaporate.
•	 In cases where stacking is unavoidable, a paper interleaf should be placed 

between each print.

Conditions of Use:
•	 Where possible, all paper should be stored and used within the following 

range of environmental conditions:
Temperature = 10°- 35°Centigrade
Relative Humidity = 30% - 80%

•	 Unused paper should be stored in its original packaging, out of direct 
sunlight under normal climatic conditions.

All recommendations and product indications are for your guidance, and are subject 
to our test criteria. 

This Ultra White Photo RC inkjet paper provides excellent image quality, on its smooth satin surface. Its Mircoporous coating is touch 
dry when printed and water resistant. It is ideal for a more subtle finish but still gives the same saturated colours and great tonal range 
as our gloss heavyweight.

Applications include; Photography, portrait printing, posters and graphic art reproduction

Directions for Use:

Photo Papers Heavyweight

Photo Satin Heavyweight 260gsm  
OLM61

P R O F E S S I O N A L  P H O T O G R A P H I C  I N K J E T  PA P E R

Weight (GSM) 260

Base Material Resin Coated

Coating Type Microporous Satin

Surface Texture Smooth Satin 

Thickness (Microns / inches) 265 / 0.016

Whiteness (CIE) 152

Brightness (TAPPI) 112

OBA content Yes

pH 7.5-9.5

Sheets Size: 
Availability / sheets per box

DIN A4 / A3 / A3+ / A2  - 50 sheets 
(US sizes available on request) 

Roll Size: 
Availablity / Length / Core size

17” (432mm) / 24” (610mm) / 44” (1118mm) / 60” (1524mm) - 30m - 3” core

Printer/Ink Compatibility Compatible with all commercial thermal and piezo inkjet printers using water-based dye and 
pigment-based inks such as Epson, Canon and Hewlett-Packard

Recommended printer 
Settings

Photo black inks with generic media setting of ‘Photo Semi-gloss   heavyweight’ / ‘Premium 
Photo paper Semi-matte’ or similar. ICC colour profiles are available from the website.

Description: © Barrie Tumbridge
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Directions for Use:

Paper Handling:
•	 Avoid touching the coated surface of the paper before and after printing, 

and wear cotton gloves if necessary.
•	 Avoid exposure to high temperatures, high levels of humidity and moisture. 

These factors can affect the drying time of some Olmec™ products.

Paper Storage:
•	 Remove prints from the tray after printing; do not allow them to be stacked.
•	 Prints should be allowed to dry in air, preferably left uncovered for 24 hours 

to allow the residual liquid from the inks to evaporate.
•	 In cases where stacking is unavoidable, a paper interleaf should be placed 

between each print.

Conditions of Use:
•	 Where possible, all paper should be stored and used within the following 

range of environmental conditions:
Temperature = 10°- 35°Centigrade
Relative Humidity = 30% - 80%

•	 Unused paper should be stored in its original packaging, out of direct 
sunlight under normal climatic conditions.

All recommendations and product indications are for your guidance, and are subject 
to our test criteria. 

This Ultra White Photo RC inkjet paper provides excellent image quality, on its stippled lustre surface. Its Mircoporous coating is touch 
dry when printed and water resistant. 

Applications include; Photography, portrait printing, posters and graphic art reproduction

Photo Papers Heavyweight

Photo Lustre Heavyweight 260gsm  
OLM59

P R O F E S S I O N A L  P H O T O G R A P H I C  I N K J E T  PA P E R

Weight (GSM) 260

Base Material Resin Coated

Coating Type Microporous Satin

Surface Texture Slightly textured lustre

Thickness (Microns / inches) 265 / 0.016

Whiteness (CIE) 152

Brightness (TAPPI) 112

OBA content Yes

pH 7.5-9.5

Sheets Size: 
Availability / sheets per box

DIN A4 / A3 / A3+ / A2  - 50 sheets 
(US sizes available on request) 

Roll Size: 
Availablity / Length / Core size

17” (432mm) / 24” (610mm) / 44” (1118mm) / 60” (1524mm) - 30m - 3” core

Printer/Ink Compatibility Compatible with all commercial thermal and piezo inkjet printers using water-based dye and 
pigment-based inks such as Epson, Canon and Hewlett-Packard

Recommended printer 
Settings

Photo black inks with generic media setting of ‘Photo Semi-gloss   heavyweight’ / ‘Premium 
Photo paper Semi-matte’ or similar. ICC colour profiles are available from the website.

Description:
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Directions for Use:

Paper Handling:
•	 Avoid touching the coated surface of the paper before and after printing, 

and wear cotton gloves if necessary.
•	 Avoid exposure to high temperatures, high levels of humidity and moisture. 

These factors can affect the drying time of some Olmec™ products.

Paper Storage:
•	 Remove prints from the tray after printing; do not allow them to be stacked.
•	 Prints should be allowed to dry in air, preferably left uncovered for 24 hours 

to allow the residual liquid from the inks to evaporate.
•	 In cases where stacking is unavoidable, a paper interleaf should be placed 

between each print.

Conditions of Use:
•	 Where possible, all paper should be stored and used within the following 

range of environmental conditions:
Temperature = 10°- 35°Centigrade
Relative Humidity = 30% - 80%

•	 Unused paper should be stored in its original packaging, out of direct 
sunlight under normal climatic conditions.

All recommendations and product indications are for your guidance, and are subject 
to our test criteria. 

A Bright White Photo RC inkjet paper provides excellent image quality, on its smooth gentle gloss surface. The only RC paper in the 
range to be coated on both sides, it is ideal for albums and portfolio books.

Applications include; Photography, album printing, greetings cards, graphic art and promotional materials.

Photo Papers Double Sided

Photo Gloss Double Sided 250gsm  
OLM65

P R O F E S S I O N A L  P H O T O G R A P H I C  I N K J E T  PA P E R

Weight (GSM) 250

Base Material Resin Coated

Coating Type Microporous Gloss

Surface Texture Subtle gloss

Thickness (Microns / inches) 245 / 0.016

Whiteness (CIE) 145

Brightness (TAPPI)

OBA content Yes

pH 7.5-9.5

Sheets Size: 
Availability / sheets per box

DIN A4 / A3   - 50 sheets 
(US sizes available on request) 

Roll Size: 
Availablity / Length / Core size

N/A

Printer/Ink Compatibility Compatible with all commercial thermal and piezo inkjet printers using water-based dye and 
pigment-based inks such as Epson, Canon and Hewlett-Packard

Recommended printer 
Settings

Photo black inks with generic media setting of ‘Photo semi-gloss heavyweight’ / ‘Premium 
Photo paper semi-gloss’ or similar. ICC colour profiles are available from the website.

Description:
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Directions for Use:

Paper Handling:
•	 Avoid touching the coated surface of the paper before and after printing, 

and wear cotton gloves if necessary.
•	 Avoid exposure to high temperatures, high levels of humidity and moisture. 

These factors can affect the drying time of some Olmec™ products.

Paper Storage:
•	 Remove prints from the tray after printing; do not allow them to be stacked.
•	 Prints should be allowed to dry in air, preferably left uncovered for 24 hours 

to allow the residual liquid from the inks to evaporate.
•	 In cases where stacking is unavoidable, a paper interleaf should be placed 

between each print.

Conditions of Use:
•	 Where possible, all paper should be stored and used within the following 

range of environmental conditions:
Temperature = 10°- 35°Centigrade
Relative Humidity = 30% - 80%

•	 Unused paper should be stored in its original packaging, out of direct 
sunlight under normal climatic conditions.

All recommendations and product indications are for your guidance, and are subject 
to our test criteria. 

This Ultra White Photo Matte inkjet paper provides excellent image quality and sharpness, on its reflection free surface.

Applications include; Photography, portrait printing, posters and graphic art reproduction

Photo Papers Matte

Photo Matte Archival 230gsm  
OLM67

P R O F E S S I O N A L  P H O T O G R A P H I C  I N K J E T  PA P E R

Weight (GSM) 230

Base Material Alpha cellulose

Coating Type Matte

Surface Texture Smooth matte

Thickness (Microns / inches) 245 / 0.016

Whiteness (CIE) 130

Brightness (TAPPI)

OBA content Yes

pH 7.5-9.5

Sheets Size: 
Availability / sheets per box

DIN A4 / A3 / A3+ / A2  - 100 sheets 
(US sizes available on request) 

Roll Size: 
Availablity / Length / Core size

17” (432mm) / 24” (610mm) / 44” (1118mm) / 60” (1524mm) - 30m - 3” core

Printer/Ink Compatibility Compatible with all commercial thermal and piezo inkjet printers using water-based dye and 
pigment-based inks such as Epson, Canon and Hewlett-Packard

Recommended printer 
Settings

Photo black inks with generic media setting of ‘Photo Paper Matte’ / ‘Premium Matte Photo 
paper’ or similar. ICC colour profiles are available from the website.

Description:

BCI IMAGING SUPPLIES www.bciimage.com 866 971-1008

BCI IMAGING SUPPLIES www.bciimage.com 866 971-1008



TECHNICAL DATA SHEET

www.innovaart.com
Rev.0714 

Directions for Use:

Paper Handling:
•	 Avoid touching the coated surface of the paper before and after printing, 

and wear cotton gloves if necessary.
•	 Avoid exposure to high temperatures, high levels of humidity and moisture. 

These factors can affect the drying time of some Olmec™ products.

Paper Storage:
•	 Remove prints from the tray after printing; do not allow them to be stacked.
•	 Prints should be allowed to dry in air, preferably left uncovered for 24 hours 

to allow the residual liquid from the inks to evaporate.
•	 In cases where stacking is unavoidable, a paper interleaf should be placed 

between each print.

Conditions of Use:
•	 Where possible, all paper should be stored and used within the following 

range of environmental conditions:
Temperature = 10°- 35°Centigrade
Relative Humidity = 30% - 80%

•	 Unused paper should be stored in its original packaging, out of direct 
sunlight under normal climatic conditions.

All recommendations and product indications are for your guidance, and are subject 
to our test criteria. 

A premium, luxurious Ultra White RC inkjet paper that will do any image justice. It has a slightly textured stippled surface to give a 
subtle silky sheen to your finished image. It has a Miroporpus coating and is touch dry when printed and water resistant. 

Applications include; Photography, portrait printing, posters and exhibition printing.

Photo Papers Speciality

Photo Pearl Premium 310gsm  
OLM70

P R O F E S S I O N A L  P H O T O G R A P H I C  I N K J E T  PA P E R

Description:

Weight (GSM) 310

Base Material Resin Coated

Coating Type Microporous Pearl

Surface Texture Slightly textured pearl

Thickness (Microns / inches) 299 / 0.012

Whiteness (CIE) 145

Brightness (TAPPI)

OBA content Yes

pH 7.5-9.5

Sheets Size: 
Availability / sheets per box

DIN A4 / A3 / A3+ / A2  - 50 sheets 
(US sizes available on request) 

Roll Size: 
Availablity / Length / Core size

17” (432mm) / 24” (610mm) / 44” (1118mm)  - 25m - 3” core

Printer/Ink Compatibility Compatible with all commercial thermal and piezo inkjet printers using water-based dye and 
pigment-based inks such as Epson, Canon and Hewlett-Packard

Recommended printer 
Settings

Photo black inks with generic media setting of ‘Photo Semi-gloss / Lustre’ / ‘Premium Photo 
paper Semi-matte’ or similar. ICC colour profiles are available from the website.
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Directions for Use:

Paper Handling:
•	 Avoid touching the coated surface of the paper before and after printing, 

and wear cotton gloves if necessary.
•	 Avoid exposure to high temperatures, high levels of humidity and moisture. 

These factors can affect the drying time of some Olmec™ products.

Paper Storage:
•	 Remove prints from the tray after printing; do not allow them to be stacked.
•	 Prints should be allowed to dry in air, preferably left uncovered for 24 hours 

to allow the residual liquid from the inks to evaporate.
•	 In cases where stacking is unavoidable, a paper interleaf should be placed 

between each print.

Conditions of Use:
•	 Where possible, all paper should be stored and used within the following 

range of environmental conditions:
Temperature = 10°- 35°Centigrade
Relative Humidity = 30% - 80%

•	 Unused paper should be stored in its original packaging, out of direct 
sunlight under normal climatic conditions.

All recommendations and product indications are for your guidance, and are subject 
to our test criteria. 

The Microporous silk coating on a true barium sulphate layer is the perfect inkjet equivalent of a traditional baryta paper. Natural White 
with a gentle gloss surface gives excellent colour gamut and D-max.

Applications include; Photography, portrait printing, posters and exhibition printing.

Photo Papers Speciality

Photo Silk Fibre Baryta 310gsm  
OLM69

P R O F E S S I O N A L  P H O T O G R A P H I C  I N K J E T  PA P E R

Description:

Weight (GSM) 310

Base Material Alpha Cellulose

Coating Type Microporous Silk

Surface Texture Smooth Satin

Thickness (Microns / inches) 315 / 0.012

Whiteness (CIE) 100

Brightness (TAPPI) 96

OBA content Yes

pH 7.5-9.5

Sheets Size: 
Availability / sheets per box

DIN A4 / A3 / A3+ / A2  - 50 sheets 
(US sizes available on request) 

Roll Size: 
Availablity / Length / Core size

17” (432mm) / 24” (610mm) / 44” (1118mm)  - 15m - 3” core

Printer/Ink Compatibility Compatible with all commercial thermal and piezo inkjet printers using water-based dye and 
pigment-based inks such as Epson, Canon and Hewlett-Packard

Recommended printer 
Settings

Photo black inks with generic media setting of ‘Photo Semi-gloss / Lustre’ / ‘Premium Photo 
paper Semi-matte’ or similar. ICC colour profiles are available from the website.

©Barrie Tumbridge
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Directions for Use:

Paper Handling:
•	 Avoid touching the coated surface of the paper before and after printing, 

and wear cotton gloves if necessary.
•	 Avoid exposure to high temperatures, high levels of humidity and moisture. 

These factors can affect the drying time of some Olmec™ products.

Paper Storage:
•	 Remove prints from the tray after printing; do not allow them to be stacked.
•	 Prints should be allowed to dry in air, preferably left uncovered for 24 hours 

to allow the residual liquid from the inks to evaporate.
•	 In cases where stacking is unavoidable, a paper interleaf should be placed 

between each print.

Conditions of Use:
•	 Where possible, all paper should be stored and used within the following 

range of environmental conditions:
Temperature = 10°- 35°Centigrade
Relative Humidity = 30% - 80%

•	 Unused paper should be stored in its original packaging, out of direct 
sunlight under normal climatic conditions.

All recommendations and product indications are for your guidance, and are subject 
to our test criteria. 

This Neutral white RC paper has a pearlescent finish with a smooth gloss microporous coating to give excellent colour saturation, 
gamut and D-max.

Applications include; Photography, portrait printing, posters and exhibiton printing.

Photo Papers Speciality

Photo Metallic Gloss 260gsm  
OLM71

P R O F E S S I O N A L  P H O T O G R A P H I C  I N K J E T  PA P E R

Description:

Weight (GSM) 260

Base Material Resin Coated

Coating Type Microporous Gloss

Surface Texture Smooth pearlescant gloss

Thickness (Microns / inches) 267 / 0.011

Whiteness (CIE) 80

Brightness (TAPPI) 82

OBA content No

pH 7.5-9.5

Sheets Size: 
Availability / sheets per box

DIN A4 / A3 / A3+ / A2  - 50 sheets 
(US sizes available on request) 

Roll Size: 
Availablity / Length / Core size

17” (432mm) / 24” (610mm) / 44” (1118mm)  - 30m - 3” core

Printer/Ink Compatibility Compatible with all commercial thermal and piezo inkjet printers using water-based dye and 
pigment-based inks such as Epson, Canon and Hewlett-Packard

Recommended printer 
Settings

Photo black inks with generic media setting of ‘Premium Photo Gloss’ / ‘Premium Photo 
paper Semi-matte’ or similar. ICC colour profiles are available from the website.
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Directions for Use:

Paper Handling:
•	 Avoid touching the coated surface of the paper before and after printing, 

and wear cotton gloves if necessary.
•	 Avoid exposure to high temperatures, high levels of humidity and moisture. 

These factors can affect the drying time of some Olmec™ products.

Paper Storage:
•	 Remove prints from the tray after printing; do not allow them to be stacked.
•	 Prints should be allowed to dry in air, preferably left uncovered for 24 hours 

to allow the residual liquid from the inks to evaporate.
•	 In cases where stacking is unavoidable, a paper interleaf should be placed 

between each print.

Conditions of Use:
•	 Where possible, all paper should be stored and used within the following 

range of environmental conditions:
Temperature = 10°- 35°Centigrade
Relative Humidity = 30% - 80%

•	 Unused paper should be stored in its original packaging, out of direct 
sunlight under normal climatic conditions.

All recommendations and product indications are for your guidance, and are subject 
to our test criteria. 

This Neutral white RC paper has a pearlescent finish with a smooth, slightly stippled, lustre microporous coating, to give excellent 
colour saturation, gamut and D-max.

Applications include; Photography, portrait printing, posters and exhibiton printing.

Photo Papers Speciality

Photo Metallic Lustre 260gsm
OLM72

P R O F E S S I O N A L  P H O T O G R A P H I C  I N K J E T  PA P E R

Description:

Weight (GSM) 260

Base Material Resin Coated

Coating Type Microporous Gloss

Surface Texture Smooth pearlescant gloss

Thickness (Microns / inches) 267 / 0.011

Whiteness (CIE) 80

Brightness (TAPPI) 82

OBA content No

pH 7.5-9.5

Sheets Size: 
Availability / sheets per box

DIN A4 / A3 / A3+ / A2  - 50 sheets 
(US sizes available on request) 

Roll Size: 
Availablity / Length / Core size

17” (432mm) / 24” (610mm) / 44” (1118mm)  - 30m - 3” core

Printer/Ink Compatibility Compatible with all commercial thermal and piezo inkjet printers using water-based dye and 
pigment-based inks such as Epson, Canon and Hewlett-Packard

Recommended printer 
Settings

Photo black inks with generic media setting of ‘Photo Semi-gloss / Lustre’ / ‘Premium Photo 
paper Semi-matte’ or similar. ICC colour profiles are available from the website.

©Barrie Tumbridge
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Directions for Use:

Paper Handling:
•	 Avoid touching the coated surface of the paper before and after printing, 

and wear cotton gloves if necessary.
•	 Avoid exposure to high temperatures, high levels of humidity and moisture. 

These factors can affect the drying time of some Olmec™ products.

Paper Storage:
•	 Remove prints from the tray after printing; do not allow them to be stacked.
•	 Prints should be allowed to dry in air, preferably left uncovered for 24 hours 

to allow the residual liquid from the inks to evaporate.
•	 In cases where stacking is unavoidable, a paper interleaf should be placed 

between each print.

Conditions of Use:
•	 Where possible, all paper should be stored and used within the following 

range of environmental conditions:
Temperature = 10°- 35°Centigrade
Relative Humidity = 30% - 80%

•	 Unused paper should be stored in its original packaging, out of direct 
sunlight under normal climatic conditions.

All recommendations and product indications are for your guidance, and are subject 
to our test criteria. 

Fine Art Papers & Photo Canvas

Photo Canvas Matte 350gsm  
OLM35

P R O F E S S I O N A L  P H O T O G R A P H I C  I N K J E T  PA P E R

A true inkjet canvas with a flexible matte coating. It’s high white base gives excellent colour gamut and D-max, ideal for stretching and 
for use with water based and solvent varnishes. 

Applications include; Fine art limited and open editions, stretched canvas and gallery wraps, also compatible with the JetMaster 
Photo Wrap by Innova.

Description:

Weight (GSM) 350

Base Material Polycotton

Coating Type Matte

Surface Texture Textured true canvas weave

Thickness (Microns / inches) 405 / 0.016

Whiteness (CIE) 152

Brightness (TAPPI) 88

OBA content Yes

pH 7.5-9.5

Sheets Size: 
Availability / sheets per box

N/A

Roll Size: 
Availablity / Length / Core size

17” (432mm) / 24” (610mm) / 44” (1118mm) / 60” (1524mm)  - 15m - 3” core

Printer/Ink Compatibility Compatible with all commercial thermal and piezo inkjet printers using water-based dye and 
pigment-based inks such as Epson, Canon and Hewlett-Packard

Recommended printer 
Settings

Matte black inks with generic media setting of ‘Fine Art Canvas’ or similar. 
ICC colour profiles are available from the website.
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Directions for Use:

Paper Handling:
•	 Avoid touching the coated surface of the paper before and after printing, 

and wear cotton gloves if necessary.
•	 Avoid exposure to high temperatures, high levels of humidity and moisture. 

These factors can affect the drying time of some Olmec™ products.

Paper Storage:
•	 Remove prints from the tray after printing; do not allow them to be stacked.
•	 Prints should be allowed to dry in air, preferably left uncovered for 24 hours 

to allow the residual liquid from the inks to evaporate.
•	 In cases where stacking is unavoidable, a paper interleaf should be placed 

between each print.

Conditions of Use:
•	 Where possible, all paper should be stored and used within the following 

range of environmental conditions:
Temperature = 10°- 35°Centigrade
Relative Humidity = 30% - 80%

•	 Unused paper should be stored in its original packaging, out of direct 
sunlight under normal climatic conditions.

All recommendations and product indications are for your guidance, and are subject 
to our test criteria. 

Fine Art Papers & Photo Canvas

Photo Canvas Gloss 380gsm  
OLM36

P R O F E S S I O N A L  P H O T O G R A P H I C  I N K J E T  PA P E R

A true inkjet canvas with a flexible microporous glossy coating. The Natural white base gives enhanced tonal range and D-max. Ideal 
for stretching, instant dry and Water resistant. 
Applications include; Fine art limited and open editions, stretched canvas and gallery wraps, also compatible with the JetMaster 
Photo Wrap by Innova.

Description:

Weight (GSM) 380

Base Material Polycotton

Coating Type Microporous Gloss

Surface Texture Textured true canvas weave

Thickness (Microns / inches) 450 / 0.016

Whiteness (CIE) 85

Brightness (TAPPI) 86

OBA content Yes

pH 7.5-9.5

Sheets Size: 
Availability / sheets per box

N/A

Roll Size: 
Availablity / Length / Core size

17” (432mm) / 24” (610mm) / 44” (1118mm) / 60” (1524mm)  - 15m - 3” core

Printer/Ink Compatibility Compatible with all commercial thermal and piezo inkjet printers using water-based dye and 
pigment-based inks such as Epson, Canon and Hewlett-Packard

Recommended printer 
Settings

Photo black inks with generic media setting of ‘Photo glossy Canvas / ‘Satin Canvas’ or 
similar. ICC colour profiles are available from the website.
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Directions for Use:

Paper Handling:
•	 Avoid touching the coated surface of the paper before and after printing, 

and wear cotton gloves if necessary.
•	 Avoid exposure to high temperatures, high levels of humidity and moisture. 

These factors can affect the drying time of some Olmec™ products.

Paper Storage:
•	 Remove prints from the tray after printing; do not allow them to be stacked.
•	 Prints should be allowed to dry in air, preferably left uncovered for 24 hours 

to allow the residual liquid from the inks to evaporate.
•	 In cases where stacking is unavoidable, a paper interleaf should be placed 

between each print.

Conditions of Use:
•	 Where possible, all paper should be stored and used within the following 

range of environmental conditions:
Temperature = 10°- 35°Centigrade
Relative Humidity = 30% - 80%

•	 Unused paper should be stored in its original packaging, out of direct 
sunlight under normal climatic conditions.

All recommendations and product indications are for your guidance, and are subject 
to our test criteria. 

Fine Art Papers & Photo Canvas

Fine Art Soft White Cotton 275gsm  
OLM15

P R O F E S S I O N A L  P H O T O G R A P H I C  I N K J E T  PA P E R

The High white, 25% cotton content of this fine art paper give it a luxurious high quality feel. It has a slightly textured surface, and is 
fully archival.

Applications include; Fine art limited and open edition prints, fine art reproduction, portfolios, albums and greetings cards.

Description:

Weight (GSM) 275

Base Material Cotton and Alpha Cellulose mix

Coating Type Matte

Surface Texture Fine Art Matte slightly textured

Thickness (Microns / inches) 414 / 0.016

Whiteness (CIE) 106

Brightness (TAPPI) 96

OBA content Yes

pH 7.5-9.5

Sheets Size: 
Availability / sheets per box

DIN A4 / A3 / A3+ / A2  - 50 sheets 
(US sizes available on request) 

Roll Size: 
Availablity / Length / Core size

17” (432mm) / 24” (610mm) / 44” (1118mm) / 60” (1524mm)  - 15m - 3” core

Printer/Ink Compatibility Compatible with all commercial thermal and piezo inkjet printers using water-based dye and 
pigment-based inks such as Epson, Canon and Hewlett-Packard

Recommended printer 
Settings

Matte black inks with generic media setting of ‘Fine Art Textured’ or similar. 
ICC colour profiles are available from the website.

© Gerry Coe
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Textile

Technical Specifications

Applications
•	 Indoor and Outdoor Display
•	Large Scale Wall Graphics
•	Temporary Signage
•	Repositionable Posters
•	Wall Art
•	Décor
•	Exhibitons/Trade Show Graphics

Additional Sizes are available on request, subject to order quantity.

Handling, Use and Storage
•	 For best results use only on firm, sound painted surfaces.
•	 If unsure of the surface quality, make a small test print before 

applying to a large area.
•	 Do not apply to varnished wood without testing a small area first.
•	 Results will vary on highly textured or porous surfaces.
•	 Return unused material to the original packaging for safe storage.
•	 Remember to remove this product from the printer and secure the roll 

with tape after your job is complete.
•	 Use the lowest possible heat settings to avoid overheating the 

adhesive. 
•	 If applying to a freshly painted surface, allow the paint to fully dry 

before installation (check paint manufacturers instructions for drying 
time).

•	 For porous, textured, rough or unpainted surfaces we recommend 
applying a test print for 48 hours before a longer term installation. If 
the material shows signs of unsticking from the surface, we suggest 
that you do not continue with a large scale installation without 
preparing the surface.

•	 After printing, do not stack prints on top of each other before they 
are fully dry.

Conditions of Use
•	 The recommended climate for storage of all media is 15–20°C, relative 

humidity of 40–60%. Always store in original packaging, out of direct 
sunlight and protected from moisture. Print room conditions should be 
in the range of 15-30°C, 30–65% relative humidity.

All recommendations are for your guidance only. These are subject to our test criteria, which 
remain subject to change without prior notice.

Repositionable & Removable.

* This is recommended as a starting point

Features
•	High White
•	Superior Print Quality
•	PET Dimensionally Stable Fabric
•	Porous Surface Allows For Easy Removal Of Air Bubbles
•	Eco-Solvent, Latex and UV Ink Compatible
•	Tear Resistant
•	Adhesive Leaves No Residue
•	Sticks To All Non-Porous and Many Porous Surfaces
•	Excellent Colour Gamut

Product Description
High white eco-solvent/latex/UV ink compatible adhesive textile, featuring YouTac intelligent adhesive, repositionable, removable 
and leaves no residue on non-porous and many porous surfaces.

www.you-tac.com
ECO-SOLVENT | UV & LATEX

YouTac Textile Eco Solvent, Latex and UV
IYT-102

Rolls (30.5m/100ft Length, 3" Core) 30", 42", 54", 60"

Basic Weight (gsm) inc. Release Liner 300 Basic Weight (gsm) ex. Release Liner 170

Media Thickness (µ) inc. Release Liner 295 Media Thickness (µ) ex. Release Liner 160

Media Thickness (Inches) inc. Release Liner 0.457 Media Thickness (Inches) ex. Release Liner 0.062

Base Material Polyester Fabric

Coating Type Eco-Solvent, Latex and UV Compatible Ink Receptive Coating

Surface Texture Smooth Matte Textile Weave

Whiteness (CIE) 135.0

Brightness (TAPPI) inc. Release Liner 98.41 Brightness (TAPPI) ex. Release Liner 100.58

Opacity (%) inc. Release Liner 98.0 Opacity (%) ex. Release Liner 80.1

Media Setting* Banner

Recyclable Yes
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Technical Specifications

Additional Sizes are available on request, subject to order quantity.

Conditions of Use
•	 The recommended climate for storage of all media is 15–20°C, relative 

humidity of 40–60%. Always store in original packaging, out of direct 
sunlight and protected from moisture. Print room conditions should be 
in the range of 15-30°C, 30–65% relative humidity.

All recommendations are for your guidance only. These are subject to our test criteria, which 
remain subject to change without prior notice.

Repositionable & Removable.

* This is recommended as a starting point

Handling, Use and Storage
•	 For best results use only on firm, sound painted surfaces.
•	 If unsure of the surface quality, make a small test print before 

applying to a large area.
•	 Do not apply to varnished wood without testing a small area first.
•	 Results will vary on highly textured or porous surfaces.
•	 Return unused material to the original packaging for safe storage.
•	 Remember to remove this product from the printer and secure the roll 

with tape after your job is complete.
•	 If applying to a freshly painted surface, allow the paint to fully dry 

before installation (check paint manufacturers instructions for drying 
time).

•	 For porous, textured, rough or unpainted surfaces we recommend 
applying a test print for 48 hours before a longer term installation. If 

the material shows signs of unsticking from the surface, we suggest 
that you do not continue with a large scale installation without 
preparing the surface.

•	 After printing, do not stack prints on top of each other before they 
are fully dry.

Product Description
High white aqueous ink compatible adhesive textile, featuring YouTac intelligent adhesive, repositionable, removable and leaves no 
residue on non-porous and many porous surfaces.

Textile
www.you-tac.com

AQUEOUS

YouTac Textile Aqueous 
IYT-101

Rolls (30.5m/100ft Length, 3" Core) 17", 24", 36", 42", 60"

Basic Weight (gsm) inc. Release Liner 280 Basic Weight (gsm) ex. Release Liner 170

Media Thickness (µ) inc. Release Liner 300 Media Thickness (µ) ex. Release Liner 160

Media Thickness (Inches) inc. Release Liner 0.464 Media Thickness (Inches) ex. Release Liner 0.062

Base Material Polyester Fabric

Coating Type Water Based (Aqueous) Ink Receptive Coating

Surface Texture Smooth Matte Textile Weave

Whiteness (CIE) 150.0

Brightness (TAPPI) inc. Release Liner 100.85 Brightness (TAPPI) ex. Release Liner 107.52

Opacity (%) inc. Release Liner 89.7 Opacity (%) ex. Release Liner 75.1

Media Setting* Banner

Recyclable Yes
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Applications
•	 Indoor and Outdoor Display
•	Large Scale Wall Graphics
•	Temporary Signage
•	Repositionable Posters
•	Wall Art
•	Décor
•	Exhibitons/Trade Show Graphics

Features
•	High White
•	Superior Print Quality
•	PET Dimensionally Stable Fabric
•	Porous Surface Allows For Easy Removal Of Air Bubbles
•	Eco-Solvent, Latex and UV Ink Compatible
•	Tear Resistant
•	Adhesive Leaves No Residue
•	Sticks To All Non-Porous and Many Porous Surfaces
•	Excellent Colour Gamut
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